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1 Preface 

Intella is designed to be an email investigation and e-discovery tool. It is 

ideally suited for use by enterprise, law enforcement, and regulatory 

agencies in civil, criminal, or policy-related investigations. Intella is an 

excellent tool to prepare electronically stored information for discovery. 

Intella’s powerful indexing search engine and its unique visual presentation 

will let you quickly and easily search and review email and electronically 

stored information to find critical evidence and visualize relevant 

relationships. 

With Intella, you can...  

 Gain deeper insight through visualization 

 Search email, attachments, archives, headers, and metadata 

 Drill deeply using Intella’s unique facets 

 Group and trace email conversations  

 Preview, cull, and deduplicate email and data 

 Export results in a variety of formats for reporting, follow-up 

investigation, e-discovery, or later use 
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1.1 Document conventions 

The following section introduces you to conventions used throughout the 

Intella documentation. 

Menu Functions 

For functions that can be reached through menus, the different menu levels 

are illustrated as follows:   

Menu > Menu entry 

Important Entries 

Some text will be shown as follows: 

Important: Important information on Intella. 

These entries discuss a key concept or technical information that should, or 

must, be followed or taken into account. Please pay special attention to 

these entries. 

Notes 

Some sections provide additional information that will assist your use of 

Intella. These are displayed as shown below: 

Note: Information on function or parameter. 

Keyboard Shortcuts 

Some Intella functions can be activated or accessed through keyboard 

shortcuts. They are shown as follows:  

CTRL+E 

Tips 

A number of shortcuts, alternative methods, or general working tips are 

included throughout the documentation. These may help your workflow, or 
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provide additional information on other uses of functions. Tips are shown 

as below: 

Tip: Information on Intella. 

Folder and file names 

Folder and file names are shown as below: 

C:\Program Files\Vound\Intella\ 
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2 An introduction to 

Intella 

Intella is an instrument for data and email investigation and eDiscovery. It 

helps you search and explore information stored on your computer, 

network disks, in email boxes and PST, OST and NSF files. Intella is being 

used by Law Enforcement, Legal and regulatory bodies to do all of the 

above. 

Intella indexes all places where you expect valuable information and 

provides powerful means for retrieving that information. The important 

advantage over similar tools is that Intella presents the search results using 

facets and Cluster Maps. Facets allow you to find items based on more than 

just keywords and the visualization provided by the Cluster Maps allows 

you to see how files and emails are related to your query. 

The birds-eye view helps you gain insight in information that is available on 

combinations of keywords. In each step of your search it shows the number 

of emails or files that match your search (and of course a link to the e-mails 

and files themselves) so that you can effectively zoom in to find what you 

are looking for. 

Setting up Intella on your computer takes little time. Install the software, 

define the sources to search and explore and let Intella index the sources. 

Searching with Intella is also easy. Start as if you are using a familiar search 

engine by entering a search term, or choose any value from the information 

facets. Let Intella help you to refine your question with a list of suggested 

refinements. Use Cluster Maps to get a comprehensive overview of the 

available information. 
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2.1 Key benefits 

 Visualization of search results provides you with deeper insight. See 

how files and emails relate to parts of your query. 

 Facets, like Type, Date, and Language, help you to drill down to the 

wanted information and to focus on the information you need. 

 Search email attachments and archives, like zip files. 

 Searching is simple and requires very little training. 

 Export the search results for later use and for creation of reports. 

2.2 Intella editions 

Intella comes in seven different product editions. The table below shows the 

most important features of these editions. 

 10 

GB 

100 

GB 

250 

GB 

Professional Viewer TEAM 

Manager 

TEAM 

Reviewer 

Preparation 

   Case size limit 10 GB 100 GB 250 GB none none none none 

   Create new cases ● ● ● ●  ●  

   Index evidence files ● ● ● ●  ●  

Investigation 

   Search, filter & review ● ● ● ● ● ● ● 

   Preview items ● ● ● ● ● ● ● 

   Flag & tag items ● ● ● ● ● ● ● 

   Export items ● ● ● ● ● ● ● 

Cooperation 

   Export Cases ● ● ● ●  ● ● 

   Import Cases ● ● ● ● ● ● ● 

   Export Work Reports      ● ● 

   Import Work Reports      ●  
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2.3 Supported file formats 

Intella can extract contents and metadata of the following file formats: 

 Mail formats: 

o Microsoft Outlook PST/OST 

o Microsoft Outlook Express DBX, MBX 

o Lotus Notes NSF 

o Mbox (e.g. Thunderbird, Foxmail) 

o Saved emails (.eml, .msg) 

o Apple Mail (.emlx) 

 Document formats: 

o MS Office: Word, Excel, PowerPoint, Visio, Publisher, 

both old (e.g., .doc) and new formats (.docx) 

o OpenOffice: both OpenDocument and legacy 

OpenOffice/StarOffice formats 

o Hangul word processor (.hwp files) 

o Corel Office: WordPerfect, Quattro, Presentations 

o MS Works 

o Plain text 

o HTML 

o RTF 

o PDF 

 Archives: 

o Zip 

o Gzip 

o Bzip2 

o Tar 

o Rar 

 iCal 

 vCard 

 XML 
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2.4 Supported sources 

 Folder 

Files on local and network file systems can be indexed by Intella. 

Please check the list of supported file formats. 

 

 Microsoft Outlook file (PST, OST) 

Emails and attachments in the email archive file of Microsoft 

Outlook can be indexed by Intella. 

Versions: 97, 98, 2000, 2002, 2003, 2007 and 2010 

 

 Microsoft Outlook Express file (DBX, MBX) 

Intella will index emails and attachments stored in a Microsoft 

Outlook Express DBX  and MBX files. 

Versions: 4, 5 and 6 

 

 Lotus Notes NSF file 

Intella will index email and attachments in an email archive file of 

IBM Lotus Notes. 

Versions: IBM Lotus Notes 8.5 needs to be installed on the 

computer that runs Intella in order to process Lotus Notes NSF 

files. Intella supports all NSF files that can be processed by Lotus 

Notes version 8.5, or that can be converted to a NSF file that Lotus 

Notes 8.5 can process. 

 

 Mbox file 

Intella will index email and attachments stored in Mbox files. 

Versions: We tested Intella on several email programs that use 

Mbox files with good results, e.g. Thunderbird and Foxmail. 

 

 IMAP account 

Intella is able to access an email accounts on a IMAP email server 

and index emails and attachments. 

Versions: Intella was tested on several IMAP servers with good 
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results. However, we cannot guarantee that Intella is able to create 

IMAP account sources for every IMAP email server. 

2.5 Supported platforms 

Intella is currently only available for Windows 2000, Windows 2003, 

Windows XP, Windows Vista, and Windows 7. 

Note that Intella is not supported on Windows 2008. 

For detailed instructions about installation and running Intella, please read 

section 4: Installation and configuration. 

2.6 Version history 

2.6.1 Version 1.5.2 

General: 

 This version introduces a new product type: Intella Professional. 

Intella Professional has no hardcoded limit on the allowed 

maximum case size. 

Indexing: 

 Resolved issues with indexing folders in NSF files whose names 

contain unusual characters. 

Searching: 

 Made MD5 list search work with more plain text file encodings. 

This fix results in MD5 lists that are exported by EnCase to work 

without modifications to the file encoding. 

To benefit from this improvement, currently added MD5 lists need 

to be re-added to the case. 

 Resolved a Cluster Map selection issue that was triggered by 

combining right-clicks with the Ctrl and Shift keys. 

Exporting: 
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 Added support for exporting items as a Load File. This export is 

currently in the beta phase and may therefore change in future 

versions. Initially supported are Summation and Concordance. 

 Intella 1.5.2 makes the export to i2’s Analyst’s Notebook and iBase 

available to all license types. Introduced in Intella 1.5.1, this 

functionality was originally only available to users of Intella TEAM 

Manager. 

 Automatic numbering of exported files is now available in all 

product types. 

 Minor improvements to logging, export reports and indexing of 

large XLSX files. 

TEAM: 

 Resolved an issue with work reports that failed to properly filter 

reviewer annotations by source. 

Upgrade Notes: 

 As part of its standard procedures, Intella will detect the version 

upgrade when you open a case made with 1.5 or 1.5.1 and suggest 

that you reindex the case. 

o Reindexing of a case made with 1.5.1 is only necessary for 

cases containing XLSX files that could not be indexed. 

When this is not the case, reindexing can safely be skipped. 

o Cases made with 1.5 will open with 1.5.2, but sorting of the 

Senders and Receivers columns may not work correctly 

until the case has been reindexed. 

 Cases that were made with versions older than 1.5 cannot be 

opened. 

2.6.2 Version 1.5.1 

Installer: 

 When installing on a Windows 2008 machine, the installer no 

longer blocks installation but instead warns the user that this is not 

an officially supported platform to run Intella on. 
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Case Management: 

 Added a column in the case manager that shows the last version 

used to open a case. 

 Resolved rendering issues in the case table when a case is imported 

or renamed. 

Indexing: 

 Improved the error messages shown when an NSF file is locked by 

another application or for some other reason appears to be 

inaccessible. 

 Removed the “Add…” button from the Source Editor. The only way 

to add a source is by using the “Add New…” option in the File menu 

or through the Ctrl-N shortcut. This allows for a more streamlined 

user experience, as the indexing process that typically follows after 

adding a source blocks the main window. 

Searching: 

 Resolved an issue with keyword lists that were not being stored, 

due to illegal characters or other technical reasons. 

Results: 

 Improved sorting performance in the Details table. Both single 

column sorting and multi-column sorting benefit from major 

improvements in this area. 

 The component that lets the user select the visible columns in the 

Details table has been redesigned to allow for the growing number 

of columns. The columns are now grouped into five meaningful 

categories. 

 The Details table can now be configured what to show in the 

Senders and Receivers columns: email addresses, contact names or 

both. 

 Right-clicking on a cluster in the Cluster Map now automatically 

selects that cluster when it is not part of the current selection. This 

prevents potential confusion on what the selected operation in the 

popup menu is going to work on. 
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Exporting: 

 Added a fourth export type: iBase & Analyst’s Notebook. This 

exports out information in a format that can be imported into these 

applications with the use of the provided templates and import 

specifications. 

 Added a UTF Byte Order Mark to all generated CSV files. This 

improves how these files are displayed in Excel, especially when 

containing non-Latin characters. 

 Added a template facility to the table CSV export: a specific 

arrangement of columns can now be stored under a user-defined 

name. This facilitates optimizing frequent export tasks such as 

exporting MD5 and message hash lists. 

 Improved the performance of the first phase of exporting, where 

the items are sorted and prepared in other ways for exporting. 

 The “Export…” menu option in the table’s popup menu and other 

places is now explicitly disabled when you have selected a folder. 

 Resolved an issue with exporting items that have an exclamation 

mark in the file name, under some circumstances these files 

refused to export. 

 Improved the error messages shown during exporting that are due 

to NSF files being locked or that for some other reason are 

inaccessible. 

 Resolved an issue with exporting mails from Mbox files to a PST 

file when the Mbox file comes from a UNIX/Linux machine. The 

difference in the encoding of end-of-lines between these platforms 

corrupted the display of certain mails. 

TEAM: 

 Resolved an issue with work reports failing to import due to tag 

names that are already in use. This can happen when (1) a tag with 

that name is added to the master case after creation of the ICF file 

that the reviewer is using, or (2) when a work report imported 

earlier introduced a tag with the same name. Such tags can now be 

renamed or merged with an existing tag during importing. 
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Upgrade Notes: 

 As part of its standard procedures, Intella will detect the version 

upgrade when you open a case made with 1.5 and suggest that you 

reindex the case. The case will work without reindexing, but sorting 

of the Senders and Receivers columns may not work correctly. 

 Cases that were made with versions older than 1.5 and could not be 

opened with 1.5 (grayed out in the Case Manager) remain 

inaccessible with version 1.5.1. 

2.6.3 Version 1.5 

General: 

 Resolved an issue with Intella 1.4.3 failing to start on some PCs, 

exiting immediately with the message “Could not create Java 

virtual machine”. 

 Reduced memory usage of the application, allowing larger cases to 

be handled. 

 Performance improvements throughout the application, making 

especially search operations and listing of facet values faster. 

 Improved number formatting throughout the application. 

Indexing: 

 Improved the robustness of text, metadata and image extraction of 

files such as PDF, Word and ZIP files. 

 Improved the extraction of deeply nested items in MS Office files. 

 Improved indexing speed on PST and NSF files. A speed 

improvement of 10-50% can be expected on most PST and NSF 

files. 

 Reduced duplicate messages extracted from NSF files. 

 Added support for indexing Hangul word processor documents 

(HWP file format). 

 Indexing speed statistics are logged to a CSV file in the logs folder, 

to facilitate the analysis of indexing performance bottlenecks. 

 Improved the UI messages that are shown during (re)indexing. 
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 Resolved an issue where certain characters in an NSF file name or 

characters in a folder name inside an NSF file resulted in the file 

not being indexed. 

 The folder tree in the Add Source wizard can now be refreshed to 

reflect changes in the file system. Right-click and choose Refresh, 

or move the wizard one step back and forth. 

 Fixed missing message hashes in certain border cases, e.g. 

recovered mails. 

 Improved parsing and handling of email senders and receivers that 

do not comply with the email standards. 

 Improved error messages on files that are broken or otherwise 

impossible to index. 

 When adding a new Folder source while using a license with a case 

size limit, a folder size check is always performed, to see if the 

chosen folder is larger than the remaining allowed case size. This 

check now shows a progress screen and can be skipped. 

 All time-outs used during indexing can now be adapted if 

necessary. 

Searching: 

 Search performance has been greatly optimized through the use of 

a new, highly tuned database. Search results will now show almost 

instantly in the Cluster Map and Details views. 

 The Source and Location facets have been merged. PST files and 

other mail container files now show up as nodes in a single folder 

tree, rather than as independent roots. 

 Folders in the Location facet can now be searched with or without 

the inclusion of their subfolders.  

 Folders can now be returned as search results. 

 Improved the results of the Show Children operation on items 

containing folders, such as certain ZIP files. 

 The Date facet now offers a calendar component for choosing the 

start and/or end date. 

 Added categories in the Type facet for Contacts and Tasks extracted 

from PST files. 
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Tagging: 

 Resolved an issue where the OK button in the Add dialog would not 

be enabled if any of the selected results already had the selected 

tag. 

 Resolved an issue with the Remove Tags dialog showing tag counts 

that were too large. 

 Tags that are already applied to all selected items are now disabled 

in the Add Tags dialog. 

 Adding and removing tags has become faster. 

Results: 

 The Title/Subject column has been split into separate Title and 

Subject columns, as some document types support both fields. 

 The counts shown in the Duplicates column (formerly the Copies in 

Source column) now reflect the number of duplicates in the entire 

case, rather than the number of duplicates within the same source. 

 Resolved an issue with the deduplication function not removing all 

duplicates of an item. 

 Enforced consistency between the Type facet’s Images branch and 

the Thumbnail view: every item that is classified as an Image will 

now be displayed in the Thumbnail view, even when the Thumbnail 

view does not support that image format. In that case a generic icon 

is displayed. 

 Improved image-related operations such as the Thumbnail viewer 

and the export to PDF when image caching is switched off. 

Exporting: 

 All terms in the index can now be exported to a text file, e.g. for use 

in a password cracking tool. For each term the field name 

(corresponding with the options in the Search options panel) and 

document frequency is optionally listed. When these options are 

used, the result will be a comma-separate value file (CSV format), 

with each keyword described on a single line. 

 Additionally, the terms of a selected set of results can be exported. 
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 Improved the folder layout of the generated folders to more closely 

reflect the location of an item in the original evidence file. 

 Resolved an issue where the generated PDF of a TIFF image would 

contain a barely readable image. The full resolution is now 

retained. 

 The folder being exported to no longer has to be empty. A warning 

is now produced when the folder is not empty. Note that each 

export run will start new export reports, they are not merged. 

 Concatenated PDFs can optionally be split in chunks of a given size. 

This improves stability of the export process. 

 Fixes for various time-out issues. All time-outs used during 

exporting can now be adapted if necessary. 

Previewer: 

 Added a Words tab. This tab shows all terms in the full-text index 

that are associated with this result, ordered by field name. These 

fields correspond with the options in the Search options panel. The 

Words tab can be used to find out why certain queries won’t match 

a particular document. The terms can be exported to a CSV file, 

together with their field names and other statistics. 

 The tree structure shown in the Tree tab now fully corresponds 

with the tree structure shown in the Location facet. 

 Improved the accuracy of hit highlighting for phrase searches. 

 The Expand button in the Tree tab now has a corresponding Stop 

button, which lets you interrupt loading of the entire tree. The 

entire tree may be very large for file types like ZIP files. 

 Enabled previewing of CSV and TSV files in their original layout. 

 On small screens the default Previewer size will be reduced to fit on 

the screen. 

 Resolved various memory leaks. 

Case Management: 

 The Case Manager disables (grays out) cases made with Intella 

1.4.3 or older. Not only are the case data files incompatible with 
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this release, opening them with Intella 1.5 might also damage these 

files. Please use Intella 1.4.3 to open these cases. 

 When opening a case, Intella would already check the presence of 

evidence files relevant for this case and give the user the 

opportunity to relocate the files, to work around changed folder 

names and drive letters. When relocating such a file, the file name 

and size of the chosen file is now checked against the name and size 

that the file had during indexing.  A warning is displayed when 

these do not match. 

 Resolved an issue with cases failing to correctly export to an ICF 

file due to the presence of certain non-ASCII characters in evidence 

file names. 

 The audit trail now lists for each tagging action what tagging 

settings were used, i.e. what type of tagging inheritance was used 

(upwards/downwards/none) and whether automatic tagging of 

duplicates was used. 

 When removing a case, the Case Manager now shows an animated 

indicator during the entire operation. Before, it would freeze until 

deletion had completed. 

 Fixed an issue where exporting an ICF file failed due to lack of disk 

space, even though the free disk space was actually sufficient to 

hold the ICF file. 

 Made the Attach Evidence dialog able to handle multiple sources 

with the same file path. 

Licensing: 

 Intella is now distributed as a single installer that automatically 

runs as the product edition licensed to you (e.g. Intella Viewer, 

Intella TEAM Manager, etc.). When licenses can be found on the 

connected dongle(s) for multiple product editions, a window is 

opened that lets the user choose the desired license. 

 The trial license is now limited to indexing 10 GB of evidence files 

per case and can export maximally 1000 items at a time. 
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 The HASP Admin Control Center sometimes used to show product 

numbers instead of product names in various overviews. This has 

been fixed; the product name should now always be shown. 

Upgrade notes: 

 Intella 1.5 is not backwards-compatible: cases made with Intella 

1.4.3 or older cannot be opened. This is because of the massive 

changes that were needed to improve search performance. 

 Starting with version 1.5, sources can no longer be removed from a 

case, only added. 

 The installer now refuses to install on Windows 2008. This has 

always been an unsupported platform on which the correct 

execution of the application cannot be guaranteed. 

2.6.4 Version 1.4.3 

Case Manager: 

 The Case Manager now shows the full product name (including 

product edition) and the product version. 

 The Case Manager now shows whether a trial license is used or, 

when running on a dongle, what the ID of the dongle is. 

Indexing: 

 Various stability improvements, including processing of very large 

XLSX files. 

 Resolved an issue where words in DOCX files were concatenated in 

the extracted text. 

 Improved text extraction quality on XLSX files. 

 Resolved several text extraction issues with certain mails, including 

Chinese mails using GB2312 encoding. 

 Resolved an issue with encrypted ZIP files not being classified as 

encrypted. 

 Resolved an issue with incorrect dates in PST files. Before, a broken 

Date header could lead to an email not having a Sent date in the 

results list. Now, when a Date header is broken, the 
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PR_CLIENT_SUBMIT_TIME field is used instead as the Sent 

value. 

 Resolved an issue with PST/OST files failing to index because of 

non-ASCII characters in the name of the PST/OST file. 

Searching: 

 Resolved an issue where the "Restore the queries that were shown 

last" option was set and tag queries failed to be restored. 

 The keyword search history now looks up previous searches in a 

case-sensitive manner. 

Results: 

 Added a Source Path column to the Details table. This shows the 

full path of the source (e.g. the PST file). This improves reviewing 

of items from a large collection of evidence files, where the 

automatically chosen source name does not provide enough 

information to discern the origin of the information. 

 Speed improvements for reviewing large documents. 

 Speed improvements for quickly iterating over a list of results. 

 Encrypted items are now displayed with a lock icon, to make it 

instantly apparent why no extracted content can be displayed. 

 Applied whitespace normalization to the Contents tab: multiple 

blank lines are reduced to one line; multiple spaces are reduced to 

one space, etc. 

 Reduced memory usage of previewing items. 

 File type icons are now shown in the Type column and in the Type 

facet. The icon depends on the application that is associated with 

that file type on the local machine. 

 The set of near-duplicates of an item no longer contains the item 

itself. 

 Improved the automatically generated name of a set of near-

duplicates. 

 Resolved an issue with the Attachment tab in the Previewer failing 

to print. 
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Tagging: 

 The tagging dialogs no longer have a shortcut button that opens the 

Tagging Preferences. Instead, the “Override tag preferences” 

subpanel has been extended with a “remember these settings” 

checkbox. 

 Resolved refresh issues in the tags list and quick tags buttons 

shown in the Previewer. 

 Resolved an issue with tags not always being propagated to other 

parts of the same mail. 

 Resolved an issue where the Previewer window would disappear 

behind the main window after applying a tag. 

 Improved the display of long tag names in the Previewer. 

Exporting: 

 Added support for export reports in HTML format. 

 Stability improvements for exporting large result sets. 

 Added the ability to let the generated PST be split automatically in 

chunks of a given size. This also improves stability of the export 

process. The export report mentions which PST an item was 

exported to. 

 Optimized the layout of the exported PDFs to improve readability 

and reduce the number of pages. 

 Applied whitespace normalization to exported PDFs: multiple 

blank lines are reduced to one, multiple spaces are reduced to one, 

etc. This improves readability. 

 When exporting to both original format and PDF at the same time, 

the PDF can now optionally link to the corresponding original 

format file. 

 Resolved an issue where the elapsed time and remaining time of 

exporting were not displayed. 

 When exporting a single item, the mouse cursor now changes into a 

busy cursor while it is creating the file. 

 Resolved an issue where an item could not be exported to a PST 

because the parent email could not be found. 
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 Resolved an issue where printed results were lacking images. 

 Resolved an issue where embedded items were not exported to a 

PDF when the “Include embedded items” option was switched on. 

 Attachments from EML and MSG files that are exported to original 

format now go into a folder nested in the message’s folder and 

named after the message’s subject (similar to PST, NSF, etc.). 

Before they would go into a numbered folder in the source root 

folder. 

 When an item fails to export due to some error, it is no longer given 

the Exported status. 

 The Export dialog now has an inline help option to explain what 

happens with email dates when exporting to a PST file. 

 Rephrased some Export to PDF options for clarification. 

 Improved export status messages. 

 The default export folder has been changed from the user’s home 

folder to the Desktop folder. 

General: 

 Improved various error messages. 

 Various changes were made to protect Intella’s databases against 

file corruption when an Intella process is terminated through the 

Task Manager. 

 Improved automatic clean-up of temporary files, usually made 

during indexing and exporting. 

 Various improvements to the information in the log files. 

TEAM: 

 The file numbering option in the Export dialog is now only enabled 

when Original Format and/or PDF is selected. 

 The Tags and Features facets make a better distinction between 

tags, flags and comments made by the case manager and by a 

reviewer. Before, the difference was only clearly visible to the case 

manager. 
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2.6.5 Version 1.4.2 

Indexing: 

 Optimized memory usage of indexing of PST/OST/NSF files. 

 Improved text and image extraction accuracy of PDF and MS Office 

files. 

 Improved folder extraction of PST files that are made using the 

Hotmail Connector plugin for MS Outlook. 

 Resolved an issue with near-duplicate hashing, where generated 

mail sources did not inherit the setting of the original Folder 

source. 

 Resolved an issue with the Refresh operation incorrectly reporting 

removed items. 

Search and Review: 

 The date facet now allows the user to search a date range using 

multiple date attributes simultaneously. Prior to Intella 1.4.2, a 

drop-down list of attributes was provided, allowing the user to use 

only a single attribute per search. 

 The user now has the ability to sort columns in the Details list by 

selecting the new Sort Table button. The user can sort based on 

multiple search criteria in both ascending and descending order. 

The Sort Table button is located in the upper-right corner of the 

details pane. 

 The Intella Previewer contains a new tab called Tree.  This tab 

allows the user to see the entire path, from root to descendants, of 

the selected item being reviewed, along with clickable file names 

and email subjects. 

The tab shows a column with checkboxes that can be used to tag 

multiple items at once. The user can also right-click and choose to 

select all above or select all below the clicked item 

 The ability to search for child items is now available by 

o Right-clicking the search results in the details list and 

selecting Show children. 
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o Selecting Show children from the Explore tab of the 

Previewer. 

Show children can search for directly or indirectly nested children. 

The preferred method can be specified in every search or set in the 

Search preferences. 

 The Show parents option now allows the user to specify the level of 

search by selecting top-level parents or direct parents of the 

selected items. This option also allows the user to only consider the 

emails in the path (ignores items that are not email items) and to 

add all items that are already top-level items to the result. 

 The number of copies is now displayed correctly in the Previewer 

when the number of copies equals 1 (two items with the same 

hash). 

 The Preview tab, which allows the user to preview an item in its 

original layout, will appear for supported file types only. 

Tagging: 

 An inherited tagging feature is now available in the Add tag dialog. 

This feature allow the user to either tag the selected item only 

(item), tag all attached/nested items (item + children), or tag all 

other items nested in the same top-level item (parents + item + 

siblings + children). 

 The user can also choose to automatically tag copies of the item by 

checking Tag all copies. 

 These options can also be configured globally on the Tagging 

preferences tab. 

Exporting: 

 Additional options have been added for exporting to MS Outlook 

PST format. 

o The user can indicate how selected files that cannot be 

exported to a PST file directly should be handled: 

 Replace with its top-level parent email 

 Replace with its direct parent email 

 Skip 
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o The user can indicate how selected emails that are also 

attachments should be handled: 

 Replace with its top-level parent email 

 Export the selected attached email 

 The Source, Location and Tags values in exported PDFs are now 

located on the second page of the PDF under Properties. The user 

has the ability to exclude the Properties section when creating PDF 

exports. This allows potentially sensitive information to be 

excluded from the export. 

 Improvements have been made to the export progress dialog.   

o The dialog no longer blocks the Intella user interface. 

o The elapsed time and the estimated time remaining are 

now displayed. 

 Resolved issues with files that previously could not be exported by 

Intella. 

 Intella no longer places items that fail to export in the Exported 

category of the Features facet. 

 Improved tab printing capability of item contents. 

 The file chooser in the Export dialog is now able to create new 

folders in non-regular Windows folders, such as the Desktop and 

My Documents. 

 After exporting an entire case to an .icf file, a dialog will show the 

path of the created .icf file together with the paths of all evidence 

files that also need to be distributed to those importing the case. 

TEAM: 

 The default TEAM work folder has changed from C:\Users\USER 

to C:\Users\USER\Desktop. 

General: 

 You can now move and resize the Intella user interface when the 

Add New Source wizard is open, e.g. after opening a newly created 

case. 

 If Intella fails to open a case, an improved initialization error 

message will provide the user with possible causes and solutions. 
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 Improved the warning dialog that is shown when opening a case 

made with a different Intella version. 

Upgrade Notes: 

 Cases made with Intella 1.4.2 cannot be opened by older versions 

due to changes made to the text indexing. 

 Existing cases made with earlier Intella versions can be opened by 

Intella 1.4.2 but will require the case to be re-indexed. Tags, flags 

and comments will be preserved when upgrading from 1.4.(1) to 

1.4.2. For cases made with older versions, please check earlier 

upgrade notes. 

2.6.6 Version 1.4.1 

 Resolved an error that could occur during importing of large Intella 

case files (.icf file extension).  Importing of these files would 

typically exit immediately with an error message stating that the 

case file is not valid.  ICF files on which this error occurred will 

have to be recreated with version 1.4.1. 

 Phrase searches using smart quotes are now supported. Such quote 

characters are typically inserted by word processors like Microsoft 

Word when typing the quote character. 

 Resolved an issue with recovered mails from PST/OST files that 

could not be exported. 

 Resolved an indexing error that occurred on empty folders in 

PST/OST files. 

 Intella cannot export to PST files when the full path to the PST file 

is longer than 256 characters. Attempting to do so would result in a 

cryptic export error.  Intella now checks the length of the path and 

gives a more informative error message.  This allows the user to fix 

the path before proceeding with the export. 

 Improved PST/OST indexing debug messages. 

Upgrade Notes: 

 As always, a full re-index of the case is necessary to benefit from the 

changes in this version.  After re-indexing a case made with version 
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1.4.0, the database IDs of recovered mails may have changed. 

Consequently, the tags, flags and comments of these recovered 

mails may be lost. 

Regular (non-recovered) PST/OST mails as well as mails from 

other mail sources are not affected; their tags, flags and comments 

will be retained during a full re-index. 

2.6.7 Version 1.4 

Intella 1.4 delivers significant new features, enhancements and 

performance improvements to Intella. Version 1.4 also introduces a new 

product:  Intella TEAM. 

Intella TEAM enables multiple individuals (reviewers, investigators, 

paralegals, etc.) to review evidence independently and simultaneously.  

Their individual work products can then easily be merged into a single 

result.  Intella TEAM has two components: 

1. Intella TEAM Manager is the primary component and performs 

three critical functions: 

a. Indexing & preparation of the case data or evidence 

b. Sharing of the case data among others 

c. Combining the work product of others 

2. Intella TEAM Reviewers provide the ability to independently 

search, filter, bookmark, tag, and comment on the case data and 

transfer the results of that work back to the TEAM Manager.   

Important Note: Intella TEAM Reviewers CANNOT index or re-index the 

case data.  Only the TEAM Manager can index data. 

Case Management: 

 Indexed evidence files may now be moved and accessed more 

easily.  Previous Intella versions required that evidence files were to 

always be found at the same location, the initially used for 

indexing.  That restriction made moving evidence difficult. 
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 Intella will now detect moved files during startup and open a 

dialogue that will enable the user to locate the drives, folders, or 

files. 

 Allows for browsing to existing case folders. 

 Case importing and exporting now checks for available storage 

space before starting the operation. 

 Case importing and exporting operations now include progress 

monitors and the ability to interrupt the process. 

 When importing cases, the target location can now be specified. 

(Previously, only the default location was possible.) 

 Importing now accepts ZIP files containing an entire case. 

 When importing a case that is already present, a warning is now 

given. 

 The “Remove” button is renamed “Delete” and a clear warning 

message is provided. 

 Error fixes were applied to: 

o Keyword search history and other stored preferences 

related to exporting a case 

o A log file issue related to the use of brackets or other 

special characters in a case name. 

Indexing: 

 Added extraction of images from PDF files. 

 Added support for Foxmail email boxes (.box).  Because Intella 

Rel.1.4 treats .box as a special subtype of Mbox files, use the Mbox 

source type when indexing.  When .box files are contained in a 

folder, Intella will generate the required Mbox source 

automatically. 

 Added support for Apple Mail email boxes (.emlx files).  Because 

Apple Mail stores every email as a single .emlx file, use the Folder 

source to index. 

 Added detection of AppleDouble header files containing Apple 

Resource Forks.   

 Added support for older Outlook Express 4 (.mbx files).  
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 Intella-generated source names are now always unique.  Thus 

multiple and different Outlook.pst files will result in sources of 

differing names, e.g. “Outlook.pst” and “Outlook.pst (2)”, etc. 

 Added an artificial X-Intella-Type header to items that actually 

represent other PST/OST artifacts such as notes, tasks, contacts, 

meeting requests, etc. 

 Error fixes were applied to: 

o Time-out issues with certain email files. 

o Enabled indexing of PSTs containing unnamed folders. 

o Enabled proper indexing of emails with no subject lines. 

Searching and Reviewing: 

 Added a Preview tab in the Previewer window, rendering the 

selected item in its original layout, limited to the first few pages 

(hence “Preview”).  For example, the first few pages of a Word 

document can be shown with its original formatting, embedded 

images, etc.  This functionality is limited to Word, Excel, 

PowerPoint, PDF, RTF, HTML, OpenOffice and WordPerfect files. 

The Preview capability requires MS Office to be installed (Office 

2007 requires PDF Add-in). 
 Added new categories to the Features facet: 

o “Previewed” shows all items that have been opened in the 

Previewer. 

o “Opened” shows all items that have been opened in their 

native application. 

o “Exported” shows all items that have been exported. 

o “Unread” shows all emails that have an unread status in the 

evidence file (applicable to PST/OST only). 

o "Empty Document" identifies all items that have no text 

but where text would normally be expected.  A common 

scenario is a PDF file where all text is contained in images, 

typically a scanned document.  The results of this category 

are typically candidates for OCR or encryption cracking 

tools. 
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 Several of the Features facets are now "multi-user aware.”  That is, 

after importing one or more work reports in the Team Manager 

version, you can see which files were previewed, tagged, etc. and by 

whom.  

 Improved memory usage when querying large amounts of items. 

 The Auto-Advance option in the Previewer window has been made 

persistent. 

 The Previewer now checks for unapplied comments before allowing 

the user to close the window. 

 As a precaution, the tagging, commenting and flagging code verifies 

that those annotations are stored accurately and shows an error 

message when this is not the case. 

 The “Copies” column has been renamed to the more accurately 

“Copies within source”.  Also “Show copies” has been renamed to 

“Show copies within source”.  

 The semantics of the Copies column and Show Copies functionality 

has been changed:  when searching for all copies of an item, the 

item itself is no longer returned. Thus the count is one less than 

before. 

 The “MD5 Hash” facet has been renamed to “MD5 and Message 

Hash”. 

 Changed the Location facet to show the source file names as the 

roots for PST, OST and NSF files. This solves the problem of a large 

list of folders all named “Ext-Root,” now making it apparent which 

email file they relate to. 

 Error fixes applied to: 

o Hit highlighting in the Previewer 

o Missing file names for EML and MSG files in the Previewer 

o Incomplete highlighting of values in the Location facet 

Exporting: 

 Improved the layout of the export dialog to more efficiently use the 

available window space. 

 Exporting to PST has a revised set of options, giving more control 

over what is exported into the PDF. 
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 Added the ability to add the original rendering of an item to the 

exported PDF, i.e. the contents of a Word document is shown 

exactly as Word shows it. 

 In Team Manager and Team Reviewer only: added the ability to 

consecutively number exported files, optionally with a prefix and 

given start number. 

 Exported PDFs have simplified headers and footers – optionally 

only the consecutive number is displayed in the footer. 

 The export order has been improved:  

o First, all items are sorted by source.  

o Next, emails are sorted by Sent date. 

o Each email is immediately followed by its attachments.  

o Each attachment is directly followed by any embedded 

items.  

The order is relevant for export reports and when concatenating all 

exported PDFs into a single PDF. 

 Exporting of results into their original format has been made much 

faster. 

 Improved memory usage when exporting large amounts of items.  

When exporting items while memory usage is already high, Intella 

may suggest removal of the search results from the screen before 

continuing with exporting the selected set.  This frees memory for 

the export process. 

 Improved validation of user-entered information in the export 

dialog. 

 Added a CSV export report type. The CSV report lists all item 

metadata, accompanied by the names of the exported files in 

original format and PDF format.  When using consecutive 

numbering of exported files, the prefix and number is listed as a 

separate column.  Finally, the last column contains any export 

errors that occurred. 

 PDF and RTF export reports now show a divider between the item 

sets of different sources. The PDF report uses headings that appear 



Page 40| Intella™ User Manual | © 2011 Vound, LLC 

in Adobe Acrobat as bookmarks.  This can be used to quickly jump 

to the items of a specific source. 

 Improved the export folder layout.  Items in their original format, 

PDFs and PSTs, are clearly separated. 

 Error fixes applied to: 

o Fixes for multipart/alternative emails that were missing 

HTML parts when exported. 

o Fixes for exporting emails with non-Latin content to PDF. 

2.6.8 Version 1.3.4 

 This release contains a fix that ensures that folder names inside 

PST and OST files are indexed, so that you can find emails using 

keyword search on the folder names. Previously this was not done 

for PST and OST files. Other mail formats did not have this 

problem. 

2.6.9 Version 1.3.3 

 Further improvements in recovery of deleted mail from PST/OST 

files. 

2.6.10 Version 1.3.2 

User Interface Improvements and Fixes: 
 

 Tagging Fix:  The “Tags” line in the properties panel of the 

Previewer updates correctly now when the last tag is removed from 

a tagged item. 

 Lotus Notes validation:  Improved user notification makes it clearer 

that Lotus Notes application files are missing or that the detected 

Lotus Notes version doesn't meet the required minimal (most 

current) version. 

 Menu Bar Update Notification Fix:  When the “Update Notification 

Message” on the Menu Bar is selected in Windows 7 the correct 

browser window (on the Vound website) now opens. 

 Case Importing Fix:  A network connection is NOT required when 

importing a case.  
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Indexing Improvements and Fixes: 
 

 Lotus Notes indexing fixes: 

 Fixed missing last modification dates for attached messages in an 

NSF file. 

 Fixed missing inline images in RichTextItems in an NSF file. 

 Stability improvements for memory-intensive indexing tasks. 

 Improved PDF text and metadata extraction accuracy. 

 Removed all quotes from the displayed contact name in the Sender 

and Receiver columns in the Details Panel and the Email Address 

Facet 

 
Exporting Improvements and Fixes: 
 

 Stability improvements for the PST creation process.  

 Improved the recovery of deleted mail from PST files, resulting in 

more extracted mail and attachments. 

 Corrected issue that caused exported messages to be labeled 

“unread” when opened in Outlook 2007 and earlier versions. 

 Mbox mail fix:  Corrected folder path of exported Mbox mail to 

remove the path of the Mbox source file. 

2.6.11 Version 1.3.1 

New Features: 

 Comments can now be added to items in the Previewer.  Comments 

are searchable, displayed as a column in the Results table and can 

be exported.       

 Import and Export Cases via the Case Manager to allow cases to be 

shared among multiple reviewers.  An exported .icf file allows easy 

transportability and ensures integrity of the exported case.  The 

import button allows the reviewer to select an .icf file for importing 

into the cases folder. 

 TimeLine View can now be exported as a PNG image 
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 Search History can now be selected or turned off by user 

preference. 

 Message ID Column is added to the Results table to display the 

value of the email’s message ID.  If no such header is present in an 

email, the column shows the Mapi-Smtp-Message-Id or Mapi-125-

Message-Id header. 

Improved and Enhanced Features: 

 The MD5 column in the Results table now only shows the MD5 

hashes of binary items (attached files and electronically stored 

information).  A new Message Hash column shows hashes for email 

messages. 

 The Message Hash algorithm has been rewritten so that the 

Message Hash values will remain constant when a case is reindexed 

with a newer Intella version. 

 Improved the ability to recover deleted mails from PST and OST 

files. 

 Exporting results as PDF files includes several refinements:  

o All PDF output can be concatenated into a single file 

instead of one file per result. 

o Options have been added to control the inclusion of email 

headers, extended properties and comments in the PDF 

document. 

 Results tables that are exported to CSV now use a date format 

recognized by Excel, making it possible to accurately sort on these 

values.   

 The ability to export lists of facet fields and their counts has been 

expanded to all facets.  Enabling a reviewer, for example, to export 

a all document types and their counts, document authors and their 

counts, email addresses and their counts. 

 The Case Manager now shows the size of each case.  A feature of 

particular importance to Intella 10 users. 

 The indexing statistics shown on the interface at the conclusion of 

indexing (number of files, messages, elapsed time, etc.) are now 

added to the log file and available for viewing. 
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 Because some facets take additional time to initialize, user activity 

in this state is now disabled so as to prevent incomplete CSV 

exports of these values. 

 The text and metadata extraction accuracy of OpenXML files, also 

known as the MS Office 2007 formats (.docx, .pptx, .xlsx, ...) has 

been improved. 

 Improved the extraction of values from vCards. 

 Renamed the "Index images inside documents" option to "Index 

content embedded in documents," to more accurately describe 

what is controlled by this option. 

Fixes: 

 Fixed a problem with PST, OST or NSF files that failed to index due 

to a "No response from external process" error. 

 Fixed broken Export to PST functionality due to a conflict with 

another installed application. 

 Fixes for missing receivers in mails from PST/OST files. 

 Fixes for missing dates in MSG files. 

 Fixes for incorrect decoding of mail subjects, senders, receivers and 

dates. 

 Fixes for incorrect representation of encrypted messages in 

PST/OST files. 

 Fixes for incorrect attachments in NSF files. 

 Fixes for the incorrect representation of attached messages in NSF 

files. 

 Fixed problems with previewing mails that lack a subject. 

 Fixed failing indexing of evidence files that have a hash character 

('#') in their paths. 

 Fixed errors with exporting mails from Mbox sources. 

 The Thumbnails tab in the Previewer was sometimes not reset, 

resulting in the Thumbnails of the previous result being shown as 

part of the current result. 

 Korean characters in case names were replaced by dashes in the 

suggested case folder. 
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 When Intella detects a version upgrade when you open a case, a 

dialog is opened that suggests reindexing of the case. A problem 

where this dialog appeared every time the case was opened has 

been fixed. 

 When a case was moved to a different location, the ability to show 

thumbnails was lost due to the use of absolute paths in the 

database. Those absolute paths have been replaced by relative 

paths. 

 Near-duplicate hashes are no longer calculated for items without 

text.  This prevents these items from being considered to be near-

duplicates. 

 The counts in the Features facet were not updated instantly when 

results were tagged, flagged or commented on. 

 The Tags facet should show user names of tag creators, not their 

UUIDs. This only affects exported cases that contain tags. 

 Export reports (RTF and PDF) should use relative paths in their 

links to the exported files, not absolute paths. 

 The Print Preview dialog will now always fit the current display, so 

that no buttons are truncated. 

Upgrade Notes: 

 As usual, when you open a case made with an earlier Intella version 

in Intella 1.3.1, Intella will detect the version upgrade and suggest 

that you reindex. Reindexing is necessary to make use of the many 

improvements outlined above. Two aspects are important to 

consider: 

 After reindexing, the message hashes will differ. We have 

redesigned the algorithm so that this is not likely to occur with 

future version upgrades. 

 Due to the requirement of a particular fix for indexing NSF files, 

some internal IDs of items extracted from these NSF files may 

differ.  A consequence of this is that tags pointing to items from 

NSF files may become incorrect: they may no longer connect to an 

item at all or may connect to a different item.  Should you have 

cases involving tagged items from NSF files, we recommend you 
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continue using the previous version for that case or, alternatively, 

completely rebuild the case with Intella 1.3.1. 

2.6.12 Version 1.3 

 Improved case management now allows better editing of case 

details, including investigator name and a case description. 

 Improved feedback on indexing. Better progress reporting and 

statistics. The dialog that shows during indexing is no longer 

blocking. You can minimize the window now. 

 Improved folder selection in New Source wizard 

 Completely reworked Previewer. Now tasks like tagging, flagging, 

and finding copies of an item are offered in a strip of grouped 

buttons organized in three categories: Review, Explore, and 

Produce. 

 Previewer is now the central instrument for productive reviewing of 

items allowing direct inspection of relations between items. For 

example: the relation between a zip-file and its entries. 

 Previewer indicates the position of search terms in the scrollbar, 

and has Next and Previous buttons to quickly browse search term 

hits. 

 Previewer indicates existence and allows you to navigate to 

duplicates (copies), near duplicates, emails in the same 

conversation, and parent items. 

 Each Previewer can loop over its own results list, so changes in the 

results table have no impact on the operation of the Next and 

Previous buttons of existing Previewers. If the table is still showing 

the same list as when the Previewer was opened, table selection will 

be updated when the Next or Previous buttons are clicked. 

 Improved thumbnail view. Thumbnails are now opened in separate 

previewer window. Like in table view, direct flagging of thumbnails 

and context menu operations are now possible. 

 Thumbnail view shows not only the selected images, but also the 

images embedded in selected documents. This happens recursively, 
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e.g., an image embedded in a MS Word document that is attached 

to an email is shown when the email is selected. 

 Extensive tagging functionality added. Tagging can now be done 

with fast tag buttons and keyboard shortcuts in the previewer. 

 New export option added: Export to PDF. This option exports all 

the selected items to separate PDF documents. 

 Item printing added. You can now print the contents of a previewer 

tab or print a report of the entire item. Added a print preview 

dialog. 

 Ability to find near-duplicates of an item. 

 Features facet added. This facet groups the following items: 

encrypted, flagged, tagged and items that have copies. 

 MD5-list option added. You can now upload a list of MD5-hashes to 

see if these hashes match with the hash value of items in your case. 

 Combined keyword lists are now supported. You can combine the 

results of all the keywords in your list in one results set. 

 Many stability improvements. Lotus Notes 8.5 or higher is now 

required for processing NSF files. 

 Sources panel is now automatically expanded when "No sources 

selected" warning is shown. 

 The Sources facet is now the default facet when a new case is 

opened. 

 New manually defined PST sources have the recovery switch by 

default set to “on.” 

 Intella now automatically detects if Lotus Notes is installed on the 

computer. It is now very simple to configure Intella for Lotus Notes 

NSF files. 

 Support for iCal and vCard added. 

 More information is extracted from PST and OST files, e.g. meeting 

requests, tasks, contacts, and appointments. 

 More information is extracted from Office files: various types of 

embedded objects. 
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 Case size limits are added. The evaluation version is limited to 

10 GB. The dongle-controlled version will come in various case size 

limits. 

 Added a License tab in the About dialog (Help > About), showing 

details of the currently active license. 

 Many fixes for non-Latin languages. 

 Support for Intella on Windows 7. 

 As always, many stability improvements! 

Notes on backward compatibility: 

 When opening a case made with Intella version 1.2.2 or earlier, tags 

made in these versions will not be recognized. 

 The MD5 hashing of email messages is changed in 1.3. The MD5 

hash value of email message made with Intella version 1.2.2 or 

earlier will be different from the MD5 hash value created with 

version 1.3. 

 Some items will have different URI’s compared to URI’s created in 

older Intella versions. 

2.6.13 Version 1.2.2 

 Stability improvements have been made for Lotus Notes (NSF) file 

indexing and exporting. In earlier releases, on rare occasions, an 

NSF file (usually a corrupt file) caused Lotus Notes to crash. When 

that happened, Intella would be shut down as well.  Enhancements 

in Release 1.2.2 will prevent Intella from crashing under that 

circumstance. Under that circumstance, Intella will now continue 

processing the remainder of the file. 

 Note that the Vound Forum contains a number of tips for fixing 

corrupt NSF files.  You can register on the Vound Forum at this 

location:  http://support.vound-software.com 

 New automatic updater that periodically checks for a newer version 

of Intella over the internet. This option may be switched off. 

 The Previewer features several improvements: 

o For archives (e.g., ZIP files), an Entries tab is shown that 

lets the user see and navigate the contents of the file. 
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o The Properties tab shows an additional number of 

metadata fields.  

o Icons are shown for known file types, making, e.g., Word 

files instantly recognizable. 

o Finally, a number of usability improvements have been 

made. 

 Previously, during a Refresh operation Intella would occasionally 

mistakenly report changed items when the evidence files had, in 

fact, not been changed.  This has been fixed. 

 The Add Source wizard remembers the last path of the chosen 

source files. 

 When navigating with the Previewer from result to result, the 

Results table will now adapt its selected row accordingly. 

 The "Export to PST" option is now explicitly disabled when Outlook 

cannot be found, rather than producing errors during export. 

 A number of fixes have been made for retrieving and interpreting 

mail messages and for indexing corrupt ZIP files. 

2.6.14 Version 1.2.1 

Indexing: 

 Extraction and indexing of Word revision logs, consisting of the last 

10 authors and full paths saved to. All authors are listed as 

contributors in the Author facet and both authors and save paths 

can be found using keyword search. Note that not all Word versions 

maintain such a log.  

 Added support for Word 6/Word 95 documents.  

 Prevent caching of images that are directly available in the file 

system.  

 Show elapsed time during indexing.  

 Mistakenly reported unchanged items during indexing of archive 

entries. 

 Broken body extraction of multipart/related messages. 

Searching: 
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 Split up the People facet in separate Email Address and Author 

facets.  

 Extended the Email Address facet with lists of all From, Sender, To, 

Cc and Bcc values.  

 Added exporting of encountered email addresses with their 

occurrence count. 

 The Date facet no longer offers pre-defined date ranges. Instead, 

the custom date range selector has been given a more prominent 

place in the interface.  

 Extended searching for dates: specify whether you want to search 

for file last modification dates, content created or last modified, 

sent or received dates. 

Previewing & Results: 

 Added columns for File Last Modified, Content Created, Content 

Last Modified, Sent and Received dates.  

 Show the full date and time of a timestamp in the Results table, 

rather than only the date.  

 Added Attachments column, showing the names of the attachments 

of a mail.  

 The Attachments tab of a previewed mail now shows the subjects of 

the attached messages.  

 The row number in the flagged column did not match the row 

number shown in the Previewer. 

Exporting: 

 Added "Create new folder" button in the Export dialog.  

 Add all known timestamps (created, last modified, etc.) of each 

exported result in an export report.  

 Export to PST: emails with non-Latin subjects could not be 

exported.  

 Fixed broken export of Chinese mails from NSF to EML.  

 Some emails exported to EML format lacked a Date header.  

 Messages with missing content could not be exported. 
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Miscellaneous: 

 HASP license server installation fixes.  

 Some preliminary Windows 7 fixes. Intella now runs on Windows 7 

with a small number of known issues left to be worked out: no log 

file is stored; opening of results in their native application 

sometimes fails. 

2.6.15 Version 1.2 

 Added an option to recover the deleted items from PST and OST 

files. 

 Index partial mails found in PST and OST files. 

 Added support for indexing Mbox files. 

 Index a folder of mail files: New sources are created automatically 

for each mail file, you are no longer required to add them one-by-

one. 

 Export search results to PST files. 

 Filter visualized results with includes and excludes sets. 

 Added a Timeline view as a fourth type of result view. 

 Added the Keyword Lists facet: search using keywords lists. 

2.6.16 Version 1.1 

 Better performance and stability with new PST and OST crawler. 

 Support for MS Outlook Express DBX files. 

 Support for RAR archives. 

 Preview shows extracted text with search term highlighting. 

 Image extraction from Word, Excel, PowerPoint and OpenXML. 

 Thumbnail viewer as an alternative for the table and list views. 

 Support for Asian languages. 

 Search on arbitrary date ranges in the Date & Time facet. 

 Support for queries that start with a wildcard ('*' or '?'). 
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2.7 Feedback 

We take great care in providing our customers with a pleasant experience, 

and therefore greatly value your feedback. You can contact us through the 

form on http://www.vound-software.com/intella/support or by mailing to 

one of the email addresses on the Contact page. 
 

http://www.vound-software.com/intella/support


Page 52| Intella™ User Manual | © 2011 Vound, LLC 

3 Getting support 

3.1 Different ways to get 

support 

Vound offers four support options designed to assist users that experience 

problems while working with Intella™: 

1. Standard technical  support 

2. User  support contract 

3. Vound User Support portal 

4. Certified Intella™ training courses 

3.1.1 Standard technical support 

Standard technical support is offered free of charge to all Vound customers 

that have a current support and maintenance contract. 

Standard technical support can be requested at the Vound support page, 

http://vound.helpserve.com/, or http://www.vound-

software.com/intella/support. 

Support is provided on business days, Monday through Friday. We attempt 

to give you a first answer within 2 business days. 

All communication will be remote – e-mail, GoToMeeting, and other means 

– and not in person unless otherwise arranged.  

Standard technical support will only be provided if your computer and 

operating system meet the minimum recommended specifications listed in 

the latest version of the Intella™ manual.  

Who is eligible for technical support? 

Our goal at Vound is to provide our customers high quality and timely 

technical support. To do this we limit technical support to the registered 

owners of Intella. Companies that allow a third party to use their Intella 
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licenses must have that third party channel all technical support through 

the original registered owner of the software.  

To ensure that we support our customers, Vound regrets it cannot support 

users who are not the original registered owner of Intella.   

What technical support is included? 

 Installation and set-up support limited to one computer in your 

environment. 

 Configuration technical support and user support on use for 

standard Intella™ options. 

 Support for errors in the software (bugs). 

Please note that Vound will make reasonable efforts to correct identified 

software errors. However this may not be achievable until a later date or 

version release.  If this is the case, the user should make efforts and take 

responsibility to achieve the required outcomes via other methods. Where 

the errors relate or are caused by corrupt data (within source files), Vound 

reserves the right to charge for the work needed to rectify the issue.   

No support can be provided… 

 When your computer does not meet the minimum or essential 

system requirements. 

 When you made any kind of modifications to the installed software. 

 When you are not using the software for its intended purpose. 

 When 3rd party applications, like virus scanners, firewalls, and 

other forensic applications, interfere with Intella™. 

 Explaining the method needed to use each feature to achieve a set 

outcome.  

Note: At no time should Vound technical support be seen as legal or 

forensic advice. Our support is given with no knowledge of the specific case 

or matter Intella is being used on. Technical support is focused on the 

correct installation and usage of Intella features.  We do not warrant that 

we are aware of all facts around the case that may be under investigation. 

As such our replies should not be seen as advice or the only way to achieve 

the required outcome. 
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3.1.2 User support contract 

A paid user support contract is offered to those customers that want 

additional user support. The user support contract provides assistance that 

falls outside the standard support package (see 1.1.1 Standard technical 

support).  

What can be included in the user support contract? 

 Help with the case or setup configuration of Intella™.  

 Assistance in using the basic and advanced features of Intella™ 

such as searching, tagging, and exporting. 

 Help with the installation of Intella™, or help with the 

configuration and set-up of your computer that runs Intella™. 

 Detailed explanation of Intella™ case management and help with 

Intella™ case setup. 

 Help with the export of search results found with Intella™ for use 

with other applications. 

 Support for using Intella™ in combination with software from 

other vendors. 

 Support for issues that a newer Intella™ release has addressed. 

How to buy to a user support contract? 

User support contracts are based on your specific needs. If you want to 

know more, please contact your nearest Vound representative or your local 

Intella™ reseller. 

3.1.3 Certified Intella™ training courses 

Vound offers a number of paid training courses for its product. These 

courses are designed to expand your effectiveness and output when using 

Intella™. It is recommended that all users take a minimum basic training 

course to ensure they are correctly using the product.  

Users who have taken a recent training course for their Intella™ product 

will be offered a discount on a paid user support contract. 



Page 55| Intella™ User Manual | © 2011 Vound, LLC 

3.2 Working with Vound support 

It is highly recommended that customers and users take advantage of the 

Vound support page when seeking assistance. The support portal takes care 

of collecting all necessary information such as the Intella version, Windows 

version, source types used, etc. and will suggest relevant articles from the 

Intella knowledge base. 

3.3 Upgrade contract 

Vound customers that purchased an Intella license are entitled to install 

free upgrades of the software for a period of one-year. In other words: an 

Intella™ license comes with a one-year upgrade contract. 

After this period purchasing an upgrade subscription will continue the 

upgrade contract. Please contact your nearest Vound representative for 

more information. 

Please know that you will only have access to standard technical support if 

you have an upgrade contract. 
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4 Installation and 

configuration 

4.1 Installation 

4.1.1 Step 1: Check the requirements! 

 Operating systems 

Intella is supported on the following operating systems: 

o Windows 2000 

o Windows 2003 

o Windows XP 

o Windows Vista 

o Windows 7 

 

 Minimum hardware configuration 

The minimum hardware configuration is an Intel Pentium 4 CPU, 

2 GHz with 2 GB RAM. 

 

 Recommended hardware configuration 

The recommended hardware configuration is a system with an Intel 

Core Duo CPU with 4 GB RAM and 2 GB of HD space. Allow extra 

space for case files and evidence data. 

 

 No need for Microsoft Office installation 

No Microsoft Office installation is required to index PST/OST files 

or any MS Office document formats. 

For exporting to PST files, Microsoft Office 2007 or higher (2010 is 

recommended) still needs to be installed locally. 
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 Lotus Notes 8.5 or higher 

In order to index NSF files, Lotus Notes 8.5 or higher is required. 

Note: Intella needs to know the location of Lotus Notes in order to index 

NSF files. Please go to File > Preferences > IBM Lotus Notes to check if the 

location is validated. 

4.1.2 Step 2: Learn about licenses and 

dongles 

Notes on the trial license that is bundled with the software that you have 

downloaded: 

 14-Day evaluation period 

The trial version runs under a HASP Software License, which gives 

you the ability to use Intella for 14 days. The 14 days evaluation 

period cannot be extended. The only way to continue using Intella 

is to purchase a dongle. 

 Trial restrictions 

Besides the 14 days of usage, the trial only allows 10 GB of evidence 

files per case. Also, exporting is limited to maximally 1000 items 

per export. 

 Continue working with a USB dongle 

If you would like to continue using Intella after this 14 day period, 

you will need to buy a license. After buying the license you will 

receive a USB dongle that will allow you to continue using the 

version you already installed.  

 System clock 

Changing the clock on your system will cause the trial to 

automatically expire. When this occurs, the only way to continue 

using Intella will be to purchase a license.  

 Virtual Machines, VMware 

The evaluation version will not work in VMware without a dongle.  

 RDP (Remote Desktop Protocol) connection 

The Intella evaluation version can only operate over an RDP 

(Remote Desktop Protocol) connection with a licensed dongle. The 
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trial license cannot be used over RDP. The dongle must be in the 

computer running the Intella software, not in the computer 

running the RDP viewer.  

 Other dongle-protected software must be closed 

All other HASP protected software, like EnCase (Guidance), Smart 

Mount (ASR Data), HBGary and i2 products, must be closed when 

installing Intella.  

4.1.3 Step 3: Install the software 

1. Download Intella through the download page on the Vound 

website: http://www.vound-software.com/ 

2. Double-click on the downloaded .exe file to launch the installer. 

Accept the license.  

3. Enter the location to store the application files and shortcuts or 

accept the default settings. All files will be extracted to the location 

of your choosing and an Intella shortcut is (optionally) placed on 

your desktop and in your Start menu. 

The application folder contains an executable called "Intella.exe" that can 

be used to launch the application. The desktop and menu shortcuts also 

start this executable. The program will start with the Case Manager 

window. 

Important: Intella will not install in an installation folder of an earlier version. 

Install a new version of Intella in a folder with a new name, for example: 

 

C:\Program Files\Vound\Intella 1.5\ 

4.2 Installation troubleshooting 

4.2.1 Error code 7 (H0007) 

"HASP key not found (H0007)" 
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This error code might be caused by other HASP dongle protected programs. 

Please close down all HASP related programs (i.e. EnCase, Smart Mount) 

and reinstall Intella. 

4.2.2 Error code 27 (H0027) 

"Terminal services detected, cannot run without a dongle (H0027)" 

This error code may be triggered because you are trying to use Intella via a 

remote desktop connection. Intella will only run via a RDP or terminal 

session with the dongle in place. 

4.2.3 Error code 31 (H0031) 

“Could not find a valid Intella license, please insert a dongle” 

This error message is shown when your trial license has expired, or when 

you unplug your dongle while Intella is running and it cannot fall back to a 

non-expired trial license. You can only continue using Intella by inserting a 

dongle. 

4.2.4 Error code 33 (H0033) 

"Unable to access HASP SRM Run-Time Environment (H0033)" 

This error code may be triggered if you run antivirus software. It is 

probably due to the antivirus software incorrectly blocking access to the 

HASP install. Please update your antivirus software to the latest virus 

definition file. 

If this problem persists, reboot your computer, open a Command Prompt 

and run (as administrator)  

<intella-dir>\bin\haspdinst.exe -i -kp 

and restart Intella. 

4.2.5 Error code 37 (H0037) 

Other HASP dongle protected software may cause this error. Please close 

down all HASP related programs (i.e. EnCase, Smart Mount) and reinstall 

Intella. 
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If this problem persists, open a Command Prompt and run (as 

administrator)  

<intella-dir>\bin\haspdinst.exe -i -kp 

and restart Intella. 

Tip: To open a Command Prompt and run as administrator (in Vista and 

Windows 7), please select Start > Accessories > Command Prompt. Right click 

and select "Run as administrator.” 

If problem persists after running this command, please open a Command 

Prompt and run (as administrator) 

net start hasplms 

4.2.6 Error code 41 (H0041) 

"Your Intella (trial) license has expired (H0041)" 

This error will be triggered if Intella is run and your trial license has 

expired. Once the trial has expired, you can only continue using Intella by 

inserting a dongle. 

4.2.7 Error code 51 (H0051) 

"Virtual machine detected, cannot run without a dongle (H0051)" 

In order to protect our intellectual property, the evaluation version of 

Intella WILL NOT run in a virtual machine (VM) environment. A “stand-

alone” machine is required. This is only true for the evaluation version; 

Intella will run in a VM environment using a dongle. 

Solution 1: Reconnect the USB dongle to your computer 

Solution 2: Install the Intella evaluation version outside a virtual machine 

4.2.8 Where are Intella's data files located? 

There is an Intella data folder in your home folder. The actual path to this 

folder depends on your platform. 

 Windows Vista and Windows 7 
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C:\Users\<USERNAME>\AppData\Roaming\Vound\Intella 

 

 Windows 2000, 2003, XP 

C:\Documents and Settings\<USERNAME>\Application 

Data\Intella 

4.2.9 Where can I find Intella’s log files? 

You can find the log files in the “logs” subfolder of the Intella data folder 

(see the previous question). 

The log files can be opened in any text editor like TextPad or NotePad++. 

Be aware that Windows’ default text editor NotePad has issues opening 

large files. 

Tip: Click Help > Open Log Folder to open the log folder. 

4.2.10 What is required to run Intella? 

1. Operating systems 

Intella supports Windows 2000, 2003, XP, Vista, Windows 7. 

 

2. Minimum hardware requirements 

The minimum hardware configuration required is an Intel Pentium 

4, 2 GHz with 2 GB RAM. 

 

3. Recommended hardware requirements 

The recommended hardware configuration is an Intel Core Duo 

with 4 GB RAM or better. Intella requires 2 GB of HD space. 

Additional disk space will be required for case files and user data. 

 

4. Microsoft Office is no longer required 

Microsoft Office 2007 is no longer required to index PST and OST 

files as it was in previous versions. 

Note: If you intend to export to PST files you will need Microsoft Office 2007 

installed on the same computer. 
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5. Lotus Notes 8.5 or higher 

In order to index NSF files, Lotus Notes 8.5 or higher is required. 

4.2.11 How to add a Lotus Notes NSF source? 

If you want to index Lotus Notes NSF files Lotus Notes 8.5 needs to be 

installed on your computer. 

If the "Lotus Notes NSF file" option is grey in the Add New Source wizard, 

please check File > Preferences > IBM Lotus Notes tab. If the status is not 

“OK”, please click Browse… and select the correct path to the installation 

folder of IBM Lotus Notes. 

4.3 Other frequently asked 

questions 

4.3.1 How is a file type determined? 

Intella looks for certain binary markers (so-called magic numbers) that 

identify certain file types regardless of the file extension (e.g., .pst, .doc, 

etc.). When this detection process fails to produce a detected file type, 

Intella uses a list of known file types by file extensions. Intella may not be 

able to determine the file type of files with non-standard (unknown) file 

extensions. 

4.3.2 Why are some characters ignored in 

search queries? 

This is caused by what is called the analyzer: before an item can be indexed, 

the analyzer breaks down the text in order to determine the individual 

words used in it. This analyzer discards white space, punctuation 

characters, etc. The same analyzer is also used to break down your query 

into individual terms. 

As non-letters and non-digits are ignored, for example, the queries 

“searchterm,” “searchterm/” and “searchterm ” (with an extra space at the 

end) all end up being equivalent. 
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4.3.3 How about live indexing (F-Response 

and Intella)? 

Some cases may require you to index files while the computer is being used, 

or across a network. For such cases we have made Intella to work with the 

best-of-breed application F-Response, by Matt Shannon. This combination 

provides you with a live forensic solution for under $300. 

You can obtain F-Response at www.f-response.com. 

4.3.4 How about email attachments? 

Intella will search both the email and the attachment for the keyword(s) 

and metadata. 

4.3.5 Can Intella deduplicate search results? 

Yes, Intella can deduplicate search results. During indexing, the checksum 

(hash) of every item is stored. Intella can be set to show or hide duplicates 

while you use it. Intella uses the MD5 hash to calculate checksums. 

4.3.6 Can Intella index an Encase image? 

Using an image mounting tool like Andy Rosen's SmartMount, Intella can 

index the Active files only. To index the unallocated you should first carve 

the image, save the data to a folder, and index that along with the image 

using Intella. 

4.3.7 Are there any EnScripts for use with an 

Encase image? 

In collaboration with a number of users Vound has created an “Export to 

Intella” EnScript. The EnScript is freely available for Intella users. Please 

contact our support department for a download link. 

This EnScript Package is designed to provide a simple, yet powerful, 

method to export relevant electronic files, including email, documents, and 

images, from EnCase to Intella for efficient investigatory review prior to full 

forensic analysis. 
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4.3.8 How to print and export PDF reports 

with characters of my language? 

By default, Intella supports printing and PDF generation for basic Latin 

character set only. To enable printing and PDF export for a language with 

another character set, you need to install an additional Unicode font that 

supports your language. 

1. Download the font file and install it in your system 

2. Copy the font file to the font subfolder of your Intella installation: 

C:\Program Files\Vound\Intella\font 

3. Restart Intella 

The font must be a Unicode TrueType font with ".ttf" file name extension. It 

is recommended that the Intella font folder contains only one font file. 

Recommendations for font selection: 

 For other languages than Chinese, Japanese or Korean, it is 

possible to install a single universal font supporting a broad range 

of character sets. You can take a look at the GNU FreeFont font 

collection at http://www.gnu.org/software/freefont/. 

 For Chinese, Japanese or Korean languages it is recommended to 

install a language-specific font. A large list of fonts for different 

languages and writing systems is available at 

http://www.wazu.jp/.If you already have the native font installed 

on your Windows system, you can copy it from 

"C:\Windows\fonts" to the Intella "font" folder. 
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5 Dongle activation 

Overall process 

To protect our intellectual property, dongles may not be activated when 

shipped. Therefore, it is necessary to activate your Intella dongle in order to 

use Intella. 

Dongle activation is a two-step process: 

 Step 1: Collect your dongle and license information and send it to 

Vound Support at: support@vound-software.com. 

 Step 2: Apply the license update file(s) you receive from Vound 

Support. 

Step 1: send dongle information 

1. Plug your dongle into an available USB port. 

 

2. Start “haspupdate.exe”. You will find haspupdate.exe in the bin 

folder in the installation folder of Intella. The default installation 

folder is: 

C:\Program Files\Vound\[Intella product folder] 
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3. Click the Collect Key Status Information tab.  

Click Collect information. 

 

4. In the dialog you will be asked to “Save key status as”. Please save 

the file with your company name. If you are activating more than 

one dongle please number the files. The file(s) you create will have 

a c2v file extension. 

 

Example: 

ACME_Forensics_1.c2v 

ACME_Forensics_2.c2v 
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5. After you clicked “Save”, you will see the “Select HASP” dialog.  

Please select HASP HL, not HASP SL! 

 

6. Record the dongle ID numbers for each dongle. This will help when 

applying the update files. 

 

7. Send the created c2v files to support@vound-software.com. 

Please ensure you include the following details in the email when 

sending the c2v files: 

a. Organization Name  

b. Address 

c. Zip code 

d. Country 

e. Contact Name 

f. Phone Number 

g. Email Address 

h. Vound Product type  –  select only one per dongle: 

i. Intella 10 GB 

ii. Intella 100 GB 

iii. Intella 250 GB 

iv. Intella Professional 

v. Intella Viewer  

vi. Intella TEAM Manager 

vii. Intella TEAM Reviewer 

 
  

mailto:support@vound-software.com
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Step 2: activate dongle 

1. Make sure your dongle is connected to the computer that runs 

Intella. 

 

2. Vound Support will send a dongle activation file. The activation 

files are dongle-specific. The file will end with a .v2c file 

extension and the name of the file contains the dongle ID. 

 

Example: HaspUpdate_68_304466763.v2c 

(the dongle ID in this case is 304466763) 

 

Save the .v2c file on your computer. Be sure to remember where it 

is stored! 

 

3. Start "haspupdate.exe" as before. You will find haspupdate.exe in 

the bin folder in the installation folder of Intella. The default 

installation folder is: 

C:\Program Files\Vound\[Intella product folder] 
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4. Click the “Apply License Update” tab. Then click the Browse button 

labeled “…” next to the “Update File” field. This opens a file selector 

dialog. 

 

5. Select the .v2c file in the file selector and click Open. 

 

6. Click “Apply update” button. This will activate the dongle. 

 

 

Your Intella dongle is now activated! 

In case of questions or problems, please contact Vound Support at 

http://www.vound-software.com/intella/support. 

 
  

http://www.vound-software.com/intella/support


Page 70| Intella™ User Manual | © 2011 Vound, LLC 

6 Intella editions and 

their workflow 

6.1 Feature Overview 

 10 

GB 

100 

GB 

250 

GB 

Professional Viewer TEAM 

Manager 

TEAM 

Reviewer 

Preparation 

   Case size limit 10 

GB 

100 GB 250 GB none none none none 

   Create new cases ● ● ● ●  ●  

   Index evidence files ● ● ● ●  ●  

Investigation 

   Search, filter & 

review 

● ● ● ● ● ● ● 

   Preview items ● ● ● ● ● ● ● 

   Flag & tag items ● ● ● ● ● ● ● 

   Export items ● ● ● ● ● ● ● 

Cooperation 

   Export Cases ● ● ● ●  ● ● 

   Import Cases ● ● ● ● ● ● ● 

   Export Work 

Reports 

     ● ● 

   Import Work 

Reports 

     ●  
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6.2 Intella 10 GB/100 GB/250 

GB/Professional 

6.2.1 Description 

Intella 10, 100 or 250 GB and Intella Professional are the powerful, 

standalone editions. They allow you to create cases, index evidence files, 

search, filter, flag, tag, comment on, and export items. 

The number in the product edition name indicates the amount of gigabytes 

of evidence files that each case can hold. Intella Professional has no such 

limit. 

Each of these editions can also be used to prepare cases that are reviewed 

using Intella Viewer. 

6.2.2 Workflow 

For standalone use: 

1. The investigator creates a case in the case manager of Intella and 

indexes evidence files. 

2. The investigator flags and tags items, and gives comments to items 

of interest. 

3. The investigator exports the results for further processing of the 

case. 

In combination with Intella Viewer: 

1. The administrator creates a case in the case manager of Intella and 

indexes evidence files. 

2. The administrator exports the case to an Intella case file (.icf file) 

using the case manager and informs the investigator where he can 

find the case file. 

3. The investigator imports the case file in Intella Viewer. The 

investigator flags and tags items, and gives comments to items of 

interest using Intella Viewer. 
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4. The investigator exports the results using Intella Viewer for further 

processing. 

6.3 Intella Viewer 

6.3.1 Description 

Intella Viewer allows the investigator to work on a case that is created by 

Intella 10/100/250 GB, Intella Professional or Intella TEAM Manager.  

6.3.2 Workflow 

In combination with Intella 10/100/250 GB, Intella Professional or Intella 

TEAM Manager: 

1. The investigator imports an Intella case file (.icf file) that is created 

with any Intella product capable of creating case files. 

2. The investigator flags and tags items, and gives comments to items 

of interest.  

3. The investigator exports the results for further processing of the 

case using Intella Viewer (Export > Result List…). 

6.4 Intella TEAM Manager and 

Intella TEAM Reviewer 

6.4.1 Description 

The Intella TEAM products make it possible to work with multiple 

investigators on the same case. In order to do so you need Intella TEAM 

Manager for the case administrator and Intella TEAM Reviewer for the 

investigators in your team. 

The case administrator creates the case in Intella TEAM Manager and 

indexes the sources with evidence files. The investigator opens the case 

created by the administrator with Intella TEAM Reviewer and starts to 

work on the case. 
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When the team members have finished their investigation, the results of 

every team member are collected and imported in Intella TEAM Manager. 

Intella TEAM Manager keeps track of the tags, flags and comments of every 

team member. 

Note: The Intella 10/100/250 GB, Professional and Viewer products cannot 

export or import Work Reports. 

6.4.2 Workflow 

1. The case administrator creates a case in Intella TEAM Manager 

using the case manager and indexes the evidence files. 

2. The case administrator exports the case to an Intella case file (.icf 

file) and informs the investigators where they can find the case file. 

3. The investigators use Intella TEAM Reviewer to import the Intella 

case file. 

4. Investigators flag, tag items and comment on items of interest. 

They export an Intella work report (.iwr file) that holds these 

annotations. 

5. The case administrator opens the case in Intella TEAM Manager 

and imports all the Intella work reports created by the 

investigators. The administrator exports the combined results for 

further processing of the case. 

Note: Just like Intella 10/100/250 GB and Intella Professional, Intella TEAM 

Manager can also be used in a standalone mode. 

6.4.3 Exporting work reports 

Exporting an Intella work report means that an *.iwr file is created (Team> 

Export Work Report…). This file contains all tags, flags and comments 

given to items by an investigator. We refer to these types of information as 

“item updates” as they extend the stored item metadata. 

Furthermore it contains the user actions on items that can be found in the 

Features facet (Previewed, Opened and Exported). 
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Finally, the audit trail is added, allowing for more precise investigator 

audits. 

In the Export Work Report dialog you can set the file name of the work 

report that is to be created. If you select the option Create CSV report, a 

CSV file will be created that contains a list of all the items that are flagged, 

tagged or commented. This CSV file lets the investigator double-check the 

tags, flags and comments that have been exported into the work report. It is 

not necessary to give this CSV to the case administrator, only the .iwr file 

will suffice. 

In the second section you can 

choose what type of updates 

will be reported: tags, flags, 

comments, action statistics 

and an audit log. You can 

further specify what tags 

should be in the report by 

clicking the Select button. 

In the third section you can 

(optionally) further restrict the 

item updates included in the 

work report. 

 By selecting Also 

include updates from 

these reviewers and by 

selecting one or more 

names after clicking 

the Select button, the work report will also contain annotations 

made by the selected investigators. This option is disabled when 

your case does not contain updates made by other reviewers. 

 Only include updates made between … and … allows you to restrict 

the work report to updates that were made in a specified date 

interval. 
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 Only include updates in these sources allows you to limit the report 

to selected sources only. 

 Only include updates from items selected in the Details view 

allows you to filter the report to the items that are currently 

selected in the Details panel. 

Creation of the work report may take some time, depending on the case size 

and the amount of updates. Afterwards a dialog is shown that lists the 

created files and statistics on how many tags/flags/etc. are stored in the 

work report. 

6.4.4 Importing work reports 

Importing work reports means that work report files (*.iwr files) created by 

investigators are added to the original case managed by the case 

administrator. Flags, tags and comments, audit logs and statistics 

generated by an investigator are imported into the case. In this way, the 

results of a team of investigators can be combined. 

Use Team > Import Work Report… menu entry will show the Open dialog. 

Select a work report and click Open.  

Important: You can only import work reports that belong to the same case. 

The Work Report History dialog shows a list of imported work reports.  Use 

to Team > Work Report History… to open this dialog. 

When you want to delete the results imported from a work report, select the 

work report in the list and click “Remove Work Report contents”. Since this 

operation can’t be undone you will be asked to confirm. 

6.5 Glossary of terms 

Preparation: The first steps in any investigation with Intella. It refers to 

managing cases and indexing evidence files. 
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Investigation: The steps taken to investigate the information that is part 

of the case. This includes preparing, searching, filtering, viewing, 

previewing, tagging, flagging, comment and exporting items. 

Cooperation: The Intella TEAM products allow investigators to cooperate 

on the same case. By exporting Intella work reports from Intella TEAM 

Reviewer and importing them to Intella TEAM Manager, the team results 

are combined into one case.  

Intella case folder: The folder where the case data (indexes, flags, tags, 

comments) is stored. Note: this is normally not the place where the 

evidence files are located. 

Intella case file: A file that contains all the data that belongs to a case 

except for the original evidence files. The file has the extension *.icf. 

Intella work folder: The folder where the work reports will be stored. 

Intella work report: A file that contains the tags, flags and comments 

made by an investigator, together with his audit trail. The Intella work 

report is sent to the case administrator. The file has the extension *.iwr. 

Case administrator: The case administrator is the person that prepares a 

case in Intella TEAM Manager, sends the case file to the investigators in the 

team and imports the Intella work reports in Intella TEAM Manager. 
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7 Managing Cases 

A case is a collection of sources that can be searched by Intella. Use cases to 

organize your work. 

7.1  The Case Manager 

 

When you start Intella, the Intella Case Manager will first show up. Here 

you can select existing cases, define new cases, and remove old ones. 

Below the cases list you can see the ID of your dongle. This can be relevant 

in conversations with Vound’s support department. When you are using a 

trial license, this line will reflect that. 

When you have your dongle inserted but still see a line indicating that you 

are using a trial license message, this could indicate technical problems 

with accessing the dongle, but also that your dongle needs to be updated to 

run with this Intella version. 
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7.1.1 Creating a new case 

 

To create a new case, select “New...” in the Case Manager window. When 

the Create New Case dialog is displayed, give the case a name, enter an 

optional description, enter an investigator name, and select a location (Data 

folder) where you want to store data that belongs to this case. 

Note: The default location, visible when you click the Suggest button, 

 

C:\Documents and Setting\<username>\Application 

Data\Intella\cases\ 

 

or 

 

C:\Users\\<username>\AppData\Roaming\Intella\cases 

 

Tip:  If the evidence has been moved after indexing, a dialog box will appear when 

opening the case that allows you to browse to the new location of the evidence 
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files.  In previous versions Intella would fail to export the files or open them in the 

associated application when the evidence was moved and it was strongly 

recommended to reserve a drive letter for the use of Intella. 

7.1.2 Opening an existing case 

In the Case Manager, select a recent case from the list and click “Open.” 

You can also use the “Browse...” button and browse to the folder containing 

the case you want to open. 

7.1.3 Editing a case 

In the Case Manager, use “Edit…” to open the “Edit case” dialog to change 

the name, description, and the investigator’s name. You cannot change the 

Data folder. 

7.1.4 Deleting an existing case 

In the Case Manager, use “Delete” to delete the case that is selected in the 

list. You will be asked to confirm the deletion. 

Important: Deleting a case will delete all files in a case folder – including any files 

that have been placed there manually by the user!  

7.1.5 Browsing cases 

In the Case Manager, use “Browse…” to open the “Choose Case File” dialog. 

Browse to the folder containing the case that you want to open. Select the 

“case.xml” file in a case folder and click “Open”. 

7.1.6 Importing a case 

In the Case Manager, use “Import” to open the “Choose Case File” dialog. 

Browse to the folder that contains the Intella Case File (.icf) you want to 

import. 
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7.1.7 Exporting a case 

In the Case Manager, use “Export” to export the selected case. Choose a 

name and folder in the “Choose file to export the case” dialog and click 

Save. 

Once the case file has been created, a dialog is shown that lists the location 

of the file, as well as the locations of all evidence files and folders used in 

the case. The case file is to be handed out to reviewers together with these 

evidence files. 

7.2 Evidence paths 

The sources menu has the entry “Edit Evidence Path…” It opens the “Attach 

Evidence” dialog. 

In this dialog you can check if the path to a folder with evidence files or the 

path to a mail file with evidence emails is still valid. If it does not find the 

folder or the mail file, the dialog allows the user to edit the path and make it 

point to the correct location. 

It is important to have the correct path to your evidence folder or mail file if 

you want to export items. Without valid evidence paths you won't be able to 

export items, preview them in their original layout or open them in their 

native application. 

Note: For Folder sources only the root folder's existence is checked. For mail 

sources the path to the mail container file is checked. 

7.2.1 Checking the evidence paths 

1. Open the “Attach Evidence” dialog with the Source > Edit Evidence 

Paths…” option. 

2. a) If the dialog shows “All evidence paths have been found”, there is 

no problem. 

b) If the dialog shows “Some evidence paths have not been found. 

Please enter their new locations.”, change the path to the evidence 

as explained in the next paragraph.  The folder icons in the 
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expanded folder tree contain the icon “Files missing within” (yellow 

sphere) and the icon “File missing” (red cross). 

7.2.2 Changing the evidence paths 

1. Open the “Attach Evidence” dialog with the Source > Edit Evidence 

Paths…” menu option. 

2. Select the file or folder node in the tree that you want to relocate. 

3. Enter the correct path in the Path field (lower end) and click Apply, 

or click the Browse button to open the path selector dialog, select a 

path and click OK. You will see the tree refresh immediately. Also 

you will see which paths still cannot be located. 

4. Click Save to save the new path. 

5. Once done, click Close to close the dialog. 

Sometimes a path is in principle correct but it can still not be found because 

a network folder has not been mounted yet or an external drive has not 

been connected. After fixing the missing network or local connection, click 

the Refresh button to retry locating the evidence paths. 



Page 82| Intella™ User Manual | © 2011 Vound, LLC 

Selections panel 
shows user’s 

queries. 

Facet panel 

shows a list of 

facets that can 

be used to 

search and filter 

results. The 

values or the 

selected facet 

are shown 

below the list. 

Details panel shows a 

table, list, thumbnail or 

timeline view of the 

results in a selected 

cluster. 

Search panel is the 
place to enter a word 

or phrase to search for. 

8 Overview of the 

Intella interface 

8.1 Main window 

  

Cluster Map panel shows how 

search results are connected to 

parts of the query. 
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8.2 Previewer 

 

Item summary: 

shows summary 

of important 

information 

related to the 

item. 

Previewer window: 

opens when item in 

table is double clicked. 

Search term hit: 

Location of search 

terms in the text. 

Item tabs:  

inspect an item’s contents, 

headers, properties, 

attachments, thumbnails, 

tree structure, extracted 

terms, comments and 

performed user actions. 

 

Previewer 

actions: click 

Review, Explore 

or Produce to see 

Previewer actions. 
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9 Sources 

Sources are one of the key concepts of Intella. They represent the locations 

where items such as emails, documents and images can be found. Sources 

are explicitly defined by the user, providing full control over what 

information is searched. 

9.1 Source types 

Intella distinguishes between various types of sources: 

 Folder sources: Directory (folder) on a local hard drive or on a 

shared/network drive containing one or more source files. 

 

 MS Outlook file (PST, OST): Storage files used by Microsoft 

Outlook for storing email and other Outlook data. 

 

Supported versions 

Intella supports PST and OST files created by the following 

versions of Microsoft Outlook: 97, 98, 2000, 2002, 2003, 2007, 

2010. 

 

 MS Outlook Express file (DBX, MBX): Email folder files for 

Microsoft Outlook Express. 

 

Supported versions  

Intella supports DBX files created by the following versions of 

Microsoft Outlook Express: 4.0, 5.0, 6.0. 

Tip: If you want to index Windows Mail files, please create a Folder 

source and index the folder where Windows Mail stores the messages. 
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 Lotus Notes NSF file: Email database file for Lotus Notes. In 

order to index NSF files, Lotus Notes 8.5 needs to be installed.  

 

Supported versions: 

Intella supports NSF files created by older versions of Lotus Notes. 

Intella supports all NSF files that can be processed by Lotus Notes 

8.5.  

Tip: The Lotus Notes tool “nudall.exe” can be used to convert older 

NSF files to NSF files that can be processed by Lotus Notes 8.5. 

 Mbox file: Storage file for Mozilla Thunderbird, Foxmail and 

other email applications. Intella has been tested on Thunderbird 

Mbox files. 

 

 IMAP account: One or more email account(s) on an IMAP email 

server. 

Important: The IMAP standard is implemented in many different ways. 

We tested Intella on several IMAP servers with good response. 

However, we cannot guarantee that Intella is able to create IMAP 

account sources for every IMAP server. 

9.2 Adding sources 

Adding sources to Intella is done with the “Add New Source” wizard. There 

are three ways to start this wizard: 

 Select “Add New...” from the Sources menu. (Sources >Add New...) 

 

 Select “Add New...” in the Sources panel in the lower left of the 

main interface. 
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 Click CTRL+N on your keyboard while using Intella. 

 

9.2.1 Adding a Folder source 

Follow these steps to add a Folder source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select a Folder, click Next, and a folder tree will be displayed. 

 

2. Specify Folder 

Select the folder from the tree containing the source files you 

want to index, or enter the folder name in the text field above 

the tree. All files in the selected folder will be indexed. When 

the “Include subfolders” checkbox is selected, files in all 

subfolders (and sub-subfolders, etc.) will also be indexed. When 
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the “Include hidden folders and files” checkbox is selected, 

hidden files and folders will be indexed as well. 

Note: Folder trees containing many items may take some time to be 

displayed. Please be patient. 

Click Next to continue. 

The last steps in the definition of a source type are almost the same for all 

types.  They are described in the section “Last steps in a source type 

definition”. Folder source definition, however, has an additional step: 

Create Mail Sources. 

 Create Mail Sources 

Intella can automatically create new sources for the mail files 

that it encounters. This will enable you to search for emails and 

attachments in these mail files. The supported formats are: 

Microsoft Outlook (PST, OST), Microsoft Outlook Express 

(DBX), Lotus Notes (NSF) and Mbox. 

Click Next to continue. 

9.2.2 Adding a MS Outlook file (PST, OST) 

source 

Follow these steps to add an MS Outlook file (PST, OST) source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select "MS Outlook file (PST, OST)" and click Next. 

 

2. Specify File 

Add the filename and location of the PST or OST file you wish 

to investigate: 

Click Open to browse for PST or OST files. 

Select the file you wish to investigate and click Open. 

Click Next to continue. 



Page 88| Intella™ User Manual | © 2011 Vound, LLC 

Tip:  When you want to index email from an active Outlook installation, you 

can find the PST file in the following directory (folder): 

 

• Windows Vista and Windows 7:  

C:\Users\<username>\AppData\Local\Microsoft\Outlook 

 

• Windows 2000, 2003 and XP:  

C:\Documents and Settings\<username>\Local 

Settings\Application Data\Microsoft\Outlook 

The last steps in the definition of a source type are almost the same for all 

types. They are described in the section “Last steps in a source type 

definition”. The MS Outlook file (PST, OST) source definition, however, has 

an additional step: Deleted items. 

 Deleted items 

Intella can recover deleted items from the Outlook data file. 

Recovered items will be located in a special folder named 

“<RECOVERED>” 

 

Select Recover deleted items if you want to recover them. 

Click Next to continue. 

9.2.3 Adding an MS Outlook Express file 

(DBX, MBX) source 

Follow these steps to add an MS Outlook Express file (DBX, MBX) source 

to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select "MS Outlook Express file (DBX, MBX)" and click Next. 

 

2. Specify File 

Add the filename and location of the DBX or MBX file you wish 

to investigate. 
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Click Open to browse folders for DBX or MBX files. 

Select the file you wish to investigate and click Open. 

Click Next to continue. 

Tip:  If you want to index email from an active Outlook Express installation, 

you can find the DBX file in the following folder... 

 

• Windows 2000, 2003 and XP:  

C:\Documents & Settings\<username>\Local 

Settings\Application Data\Identities\{<arbitrary 

string>}\Microsoft\Outlook Express 

The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.4 Adding a Lotus Notes NSF file source 

Follow these steps to add a Lotus Notes NSF file source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select “Lotus Notes NSF file” and click Next. 

 

2. Specify File 

Add filename and location of the file you wish to investigate. 

Click Open to browse for NSF files. 

Select the file you wish to investigate and click Open. 

Click Next to continue. 

Tip:  If you want to index email from an active Lotus Notes installation, you 

will find the NSF files in the following directory (folder): 

 

• Version 7.x: C:\Program Files\Lotus\Notes\Data 

 

• Version 8.x: C:\Program Files\IBM\Lotus\Notes\Data 
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The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.5 Adding an Mbox file source 

Follow these steps to add an Mbox file source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select “Mbox file” and click Next. 

 

2. Specify File 

Add filename and location of the Mbox file you wish to 

investigate. 

Click Open to browse folders for Mbox files. 

Select the file you wish to investigate and click Open 

Click Next to continue. 

 

The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.6 Adding an IMAP account source 

Follow these steps to add an IMAP Account source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select "IMAP account" and click Next. 

 

2. Specify Account 

Enter the settings for the target email account, e.g., “mail.my-

isp.com” with the username and password. Select the “use 

secure connection (SSL)” checkbox if you want or need a secure 

connection to the mail server. This is recommended, because 

without a secure connection your password will be sent as plain 
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text. 

Click Next to continue. 

 

3. Select Folders 

In the next step, Intella will contact the specified email server 

to retrieve the mail folder tree. If you selected a secure 

connection and the server uses a certificate that cannot be 

validated automatically, a dialog will appear that asks you 

whether the certificate should be accepted.  Once connected, 

after you accept the certificate if applicable, Intella will display 

the folder tree of the target mail account. You can then select 

the folders that you want to make searchable by placing a check 

in the box next to the desired folders.  

Click Next to continue. 

Note: If you want to index subfolders, you will need to select them; otherwise 

they will be ignored. The wizard has two convenient buttons for selecting and 

deselecting all folders. 

The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.7 Last steps in a source type definition 

The following final steps are the same for all source type definitions. 

1. Size Limit 

Specify the maximum allowable size for the files to be included. 

Any files larger than this size will be ignored. By default this 

limit is set to “Unlimited,” meaning that all files will be 

included. 

Use this threshold, for example, when you have exceptionally 

large PDF files (in the order of tens of megabytes) that may take 

too long to index. 

Click Next to continue. 
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2. Source Name 

Next, you are asked to enter a name for the source. The name 

will be shown in the list of sources in the Sources panel and 

functions as a label for your reference. 

Click Next to continue. 

 

3. Hashes & Duplicates 

Next, you will be asked if Intella should calculate MD5 and 

message hashes for every item indexed, if the number of 

duplicates should be calculated and if near-duplicate hashes 

should be calculated. 

 MD5 and message hashes will enable Intella to filter 

duplicates from the search results. 

 The Calculate number of duplicates option lets you see the 

number of duplicates for each indexed item. It requires 

MD5 and message hashes to be calculated. 

 The Calculate near-duplicate hashes option lets you 

retrieve results that are very similar to a selected result. 

Click Next to continue. 

Note: Calculating hashes and duplicates will slightly increase the duration of 

the indexing process. These settings cannot be changed once the source has 

been defined. 

4. Options 

Intella can optionally index the files inside archives and extract 

the images inside documents. You can disable this to improve 

indexing performance at the cost of fewer results. 

 Select Index archives if you want Intella to index files 

inside archives such as ZIP and RAR files. 

 Select Index content embedded in documents if you want 

to extract images and other binary items embedded in 

Microsoft Office, OpenOffice and PDF documents. This will 

make these items separately searchable and viewable. 
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 Select Cache images if you want to see images in the 

Thumbnail viewer. 

Click Next to continue. 

 

5. Completed Source Definition 

Finally, you will be presented with a dialog to inform you that 

you have successfully defined a new source. You may optionally 

start indexing the source. Indexing is required to be able to 

search and explore the files in this source. 

 

Once you click the Next button, the indexing process will 

proceed according to the options you have selected. 

Tip: Because the active indexing process prevents you from interacting with the 

rest of the program until finished, you may wish to skip this part now (e.g., to 

define more new sources) and index the sources later by clicking the Re-index 

menu item in the Sources menu. 

Note:  At any time except before the step "Completed Source Definition,” you 

can click the Cancel button to return to the Intella interface without adding a new 

source.  

9.3 Indexing and re-indexing 

9.3.1 Indexing 

After defining a source, Intella will index it: it will inspect all items (emails, 

files etc.) that it can find in the source file(s), enabling Intella to return 

instantaneous results during your investigation for relevant evidence. 

The creation of the first index will take quite some time as the contents of 

each file is inspected for keywords and other important metadata. 

Subsequent indexing will typically be much faster, as it only needs to 

inspect new or changed files. 
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Note:  During indexing, you will see a dialog displaying which file is currently being 

processed, as well as some statistics. You will not be able to interact with the rest 

of the program while this dialog is shown. Minimizing the main window is possible, 

however. 

The statistics in this dialog reveal the number of new, changed, removed 

and unchanged items that Intella has found in the source(s) that are being 

indexed. 

Please be aware that the numbers shown in the dialog count both files and 

folders. For example: one folder with two files in it will be counted as three 

items. As such, the number of scanned items may seem higher than the 

number of items that can be found in the source afterwards. 

You can abort the index process at any time by clicking the Stop button. 

Intella will finish processing the current item and then let you close the 

dialog. Note though that there is no way to resume the indexing process, it 

needs to be redone from scratch in a later session using the Re-index 

option. 

9.3.2 Re-indexing 

If you believe that the search results have become corrupt, for any reason, 

or you had to interrupt an earlier indexing attempt, you can always do re-

index all sources. The Re-index option is available in the Sources menu. 
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Intella will remove all indexes it has previously created and create a new 

index as it did when the sources were first added. 

The Re-index option can also be used when you opted not to index the 

sources immediately after defining them. This lets you define multiple 

sources and index them in one go. 

9.4 Editing sources 

To see the configuration of all source, go to Sources > Edit Sources or type 

CTRL+E. A dialog will open that displays the list of sources on the left. 

 

When you click on a source, its details will be shown in the area to the right 

of the list. The name and type are shown as well as source type-specific 

details such as folders to index, file size restrictions, etc. See the section on 

adding sources above for the precise meaning of these settings per source 

type. 

Only the name and the file path will be editable, the other options are fixed 

after source definition. 
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When you change the source's configuration, the Apply button is enabled. 

Changes will only be applied when you click Apply. If you select a different 

source or click the Close button without first clicking Apply, a dialog will 

appear to prompt you to apply the changes, discard the changes, or cancel 

the operation. 
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10 Searching 

To search for text, enter a query in the Search panel, and click the Search 

button. 

For query syntax rules, refer to the “Search query syntax” section below. 

10.1 Search options 

With search options you can limit keyword searching to specific item parts 

or attributes: 

 Text 

 Title / Subject 

 Summary & Description (includes e mail 

headers) 

 Path & File name 

 Authors & E-mail Addresses 

 Message Headers 

 Comments 

To see the search options, click the Options button 

under the search text field. The options box will be 

displayed below the button. 

Select the options for properties that you want to include in your search, 

and deselect those you want to exclude. Your selected search options will be 

stored and used for future searches until you change them. 

Note: As a reminder, the Options button will show a yellow triangle when 

not all options are selected.  

To hide the options box, click the Options button again. If you have made 

any changes, the icon on the Options button will change to a yellow warning 
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sign as a reminder that you have changed options that will affect your 

searches. 

10.2 Using Includes and Excludes 

10.2.1 Including search terms 

Including a search term means that only those search results that contain 

the included search term will be shown. 

Example: The user enters the search term “Paris” and includes this term 

with the dropdown menu on the Search button. The selections panel in the 

Cluster Map shows that “Paris” is an included search term. As long as this 

search term is present, only clusters with items that contain the term 

“Paris” will be shown. 

10.2.2 Excluding search terms 

Excluding a search term means that only those search results that do not 

contain the excluded search term are shown. 

Example: The user enters the search term “Paris” and excludes this term 

with the dropdown menu on the Search button. The selections panel in the 

Cluster Map shows that “Paris” is an excluded search term. This means that 

from now on only clusters with items that do not contain the term “Paris” 

will be shown. 

10.3 Search query syntax 

In the text field of the Search panel you can use special query syntax to 

perform complex multi-term queries and use other advanced capabilities. 

Tip:  You can see the list shown below by clicking the question mark button in the 

Search panel. 
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10.3.1 Use of multiple terms (AND/OR 

operators) 

By default, a query containing multiple terms matches with items that 

contain all terms anywhere in the item. For example, searching for: 

John Johnson 

returns all items that contain both “John” and “Johnson.” There is no need 

to add an AND (or “&&”) as searches are performed as such already, 

however doing so will not negatively affect your search. 

If you want to find items containing at least one term but not necessarily 

both, use one of the following queries: 

John OR Johnson 

John || Johnson 

10.3.2 Minus sign (NOT operator) 

The NOT operator excludes items that contain the term after NOT: 

John NOT Johnson 

John -Johnson 

Both queries return items that contain the word “John” and not the word 

“Johnson.” 

John -“John goes home” 

This returns all items with “John” in it, excluding items that contain the 

phrase “John goes home.” 

The NOT operator cannot be used with a single term. For example, the 

following queries will return no results: 

NOT John 

NOT “John Johnson” 
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10.3.3 Phrase search 

To search for a certain phrase (a list of words appearing right after each 

other and in that particular order), enter the phrase within full quotes in 

the search field: 

“John goes home” 

would match with the text “John goes home after work” but would not 

match the text “John goes back home after work.” 

10.3.4 Grouping 

You can use parentheses to control how your Boolean queries are 

evaluated: 

(desktop OR server) AND application 

retrieves all items that contain “desktop” and/or “server,” as well as the 

term “application.” 

10.3.5 Single and multiple character wildcard 

searches 

To perform a single character wildcard search you can use the “?” symbol. 

To perform a multiple character wildcard search you can use the “*” 

symbol. 

To search for “next” or “nest,” use: 

ne?t 

To search for “text”, “texts” or “texting” use: 

text* 

10.3.6 Fuzzy search 

Intella supports fuzzy queries, i.e., queries that roughly match the entered 

terms. For a fuzzy search, you use the tilde (“~”) symbol at the end of a 

single term: 

roam~ 
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returns items containing terms like “foam,” “roams,” “room,” etc. 

The required similarity can be controlled with an optional numeric 

parameter. The value is between 0 and 1, with a value closer to 1 resulting in 

only terms with a higher similarity matching the specified term. The 

parameter is specified like this: 

roam~0.8 

The default value of this parameter is 0.5. 

10.3.7 Proximity search 

Intella supports finding items based on words that are within a specified 

maximum distance from each other in the items text. This can be seen as a 

generalization of a phrase search. 

To do a proximity search you place a tilde (“~”) symbol at the end of a 

phrase, followed by the maximum word distance: 

“desktop application”~10 

returns items with these two words in it at a maximum of 10 words 

distance. 

10.3.8 Field-specific search 

Intella's Keyword Search searches in item texts, titles, paths, etc. By default, 

all these types of text are searched. You can override this globally by 

deselecting some of the fields in the Options, or for an individual search by 

entering the field name in your search. 

title:intella 

returns all items that contain the word “intella” in their title. 

The following field names are available: 

 text - searches in the item text 

 title - searches in titles and subjects 

 path - searches in file and folder names 

 summary - searches in descriptions, metadata keywords, etc. 
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 agent – searches in authors, contributors and email senders and 

receivers 

 headers - searches in the raw email headers 

 comment - searches in all comments made by reviewer(s) 

You can mix the use of various fields in a single query: 

intella agent:john 

searches for all items containing the word “intella” (in one of the fields 

selected in the Options) that have “john” in their author metadata or email 

senders and receivers. 
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11 Using facets 

Besides keyword searching, the indexed items can be 

browsed by facets, which represent specific item 

properties. 

Every facet organizes the items into groups (possibly 

hierarchical) depending on a specific item property. 

Selecting a facet in the Facet panel will give you a list of 

all values of the selected facet in the lower part of the 

panel. In the example on the right, the Type facet has a 

list of file types as values. 

To search for items that match with a facet value, select 

the facet value and click the Search button or double-click 

the facet value. 

Tip: To export facet information, (1) select a facet, (2) open 

the context menu - right mouse click - on the facet values, and 

(3) select Export values…. 

This will open the Export values dialog. Choose a file name 

and folder and save the export file. The CSV file will contain 

the facet values (e.g. file types, email addresses, folder names) 

and their currently shown counts, which represent their overlap with the current 

search results. 

11.1 Available facets 

11.1.1 Keyword Lists 

In the Keyword List facet you can load keyword list, to automate the 

searching with sets of previously determined search terms.  
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A keyword list is a text file in UTF-8 encoding that contains one search 

term per line. Note that a search term can also be a combination of search 

terms, like “Paris AND Lyon”. 

Once loaded, all the search terms (or queries) found in the keyword list are 

shown in the “Queries” panel in the Keyword Lists facet. They are now 

available for search. 

When the 'Combine queries' checkbox is selected, multiple terms selected 

in the 'Queries' panel will be combined to search for items matching any of 

the selected terms (Boolean OR operator). The items will be returned as a 

single set of results (one cluster).  If the checkbox is not selected, the 

selected terms will be searched separately, resulting in as many result sets 

as there are selected queries in the list. 

Tip: Keyword lists can be used to share search terms between investigators. 

11.1.2 Tags 

Tags are labels defined by the user that describe individual items.  

To refine your query with a tag, select a tag from the Tags list, and click the 

Search button below the list. 

11.1.3 MD5 and Message Hash 

Intella can calculate MD5 and message hashes to check the uniqueness of 

files and messages. If two files have the same MD5 hash, Intella considers 

them to be duplicates. Similarly, two emails with the same message hash 

are considered to be duplicates. With the MD5 and Message Hash facet you 

can: 

1. Find items with a specific MD5 or message hash and 

2. Find items that match with a list of MD5 and message hashes. 

Specific MD5 or message hash 

You can use Intella to search for files that have a specific MD5 or message 

hash. To do so, enter the hash (32 hexadecimal digits) in the field and click 

the Search button. 
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List of MD5 or message hashes 

The hash list feature allows you to search the entire case for MD5 and 

message hash values from an imported list. Create a text file (.txt) with one 

hash value per line. Use the Add… button in the MD5 Hash facet to add the 

list. Select the imported text file in the panel and click the Search button 

below the panel. The items that match with the MD5 or message hashes in 

the imported list will be returned as a single set of results (one cluster).  

Tip:  Install a free tool such as MD5 Calculator by BullZip to calculate the MD5 

hash of a file. You can then search for this calculated hash in Intella to determine if 

duplicate files have been indexed. 

Tip: Use the “Export table as CSV” option in the Details table to export all MD5 

and message hashes of a selected set of results to a CSV file. 

11.1.4 Location 

This facet represents the folder structure inside your sources. 

Select a folder and click Search to find all items in that folder. 

When “Search subfolders” is selected, the selected folder, all items 

in that folder, and all items nested in subfolders will be returned, 

i.e. all items in that entire sub-tree. 

When “Search subfolders” is not selected, only the items nested in 

that folder will be returned. Items nested in subfolders will not be 

returned, nor will the selected folder itself be returned. 

When your case consists of a single indexed folder, then the 

Location tree will show a single root representing this folder. 

Selecting this root node and clicking Search with “Search 

subfolders” switched on will therefore return all items in your 

case. 

When your case consists of multiple mail files that have been 

added separately, e.g. by using the PST and NSF source types in 

the New Source wizard, then each of these files will be 



Page 106| Intella™ User Manual | © 2011 Vound, LLC 

represented by a separate top-level node in the Location tree. 

11.1.5 Date 

This facet organizes the items into date ranges. 

You can create a custom date range by  

1. Entering a From and To date. Please note that the date entered in 

the To field is part of the date range. 

 

2. Check which date attribute(s) Intella should use: 

- File Last Modified (file items) 

- Content Created (file items and email items from PST files) 

- Content Last Modified (file items and email items from PST files) 

- Sent (all email items) 

- Received (all email items) 

Click the Search button to find items created or modified in the date range 

that you specified. The result set will be added to the details panel. 

Note: Custom date ranges cannot be stored. 

11.1.6 Type 

This facet represents the file types (Microsoft Word, PDF, JPEG, etc.), 

organized into categories like Documents, Spreadsheets, etc. To refine your 

query with a specific file type, select a type from the list and click “Search”. 

Note that you can search for both specific document types like PNG Images, 

but also for the entire Image category. 

11.1.7 Author 

This facet represents the name(s) of the person(s) involved in the creation 

of documents. The names are grouped into two categories: 

 Creator 

 Contributor 
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To refine your query by a specific creator or contributor name, select the 

name and click the Search button. 

11.1.8 Email Address 

This facet represents the names of persons involved in sending and 

receiving emails. The names are grouped in seven categories: 

 From 

 Sender 

 To 

 Cc 

 Bcc 

 All Senders (From, Sender) 

 All Receivers (To, Cc, Bcc) 

To refine your query by a specific creator or contributor name, select the 

name and click the Search button. 

Tip: You can export highlighted email addresses in a category to a CSV file by 

right clicking the category name – From, Sender, To, … – and selecting 

“Exporting highlighted values…” Email addresses are highlighted when they 

appear in the results sets. If you selected a results set (cluster) then only the email 

addresses that appear in the selected set are highlighted. 

11.1.9 Language 

This facet shows a list of languages that are automatically detected in your 

items. 

To refine your query with a specific language, select the language from the 

list and click the Search button. 

Important: If Intella cannot determine the language of an item, e.g. because the 

text is too short or mixes multiple languages, then the item will be classified as 

“Unidentified”. 
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When language detection is not applicable to the item’s file type, e.g. images, then 

the item is classified as “Not Applicable”. 

11.1.10 Size  

This facet groups items based on their byte size. 

To refine your query with a specific size range, select a value from the list 

and click the Search button. 

11.1.11 Features 

This facet allows you to identify items that fall in certain special purpose 

categories: 

 Encrypted: all items that are encrypted. Example: password-

protected PDF documents. If you select Encrypted and click the 

search button, you will be shown all items that are encrypted. 

Note: Intella detects password-protected PDF files, but before flagging 

them as Encrypted it tries to "decrypt" them with an empty password. 

This works surprisingly often. If decryption succeeds with this password, 

the file is not flagged as Encrypted by Intella because its contents are 

readable and searchable. Also know that PDF file protection is a very 

elaborate mechanism, i.e. actions like text extraction, copying, viewing 

can all be protected separately. Therefore it may be the case that text 

extraction is allowed in the PDF file's security settings, yet Adobe 

Acrobat still asks the user for a password when e.g. printing the PDF. 

Only when text extraction is disallowed will Intella flag the file as 

Encrypted. 

 

Note: Sometimes files inside an encrypted ZIP file are visible without 

entering a password, but a password still needs to be entered to extract 

the file. Such files cannot be exported with Intella. However, in this case 

both the ZIP file and its encrypted entries will be marked as Encrypted, 

so searching for all encrypted items and exporting those will capture the 

parent ZIP file. 
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 Unread: all emails that are marked as "unread" in the source file 

(PST/OST only). Note that this status is not related to previewing 

in Intella. 

 Empty document: all items that have no text while text was 

expected. Example: a PDF file with only images. 

 Has Duplicates: all items that have a copy in the same source, i.e. 

an item with the same MD5 or message hash. 

 Tagged: all items that are tagged. 

 Flagged: all items that are flagged. 

 Commented: all items that have a comment. 

 Previewed: all items that have been opened in Intella’s previewer. 

 Opened: all items that have been opened in their native 

application. 

 Exported: all items that have been exported. 

Note: In cases that have Work Reports from multiple users imported into them, 

the Previewed/Opened/Exported/Commented/Tagged/Flagged nodes shown in the 

Facet panel will have sub-nodes, one node for each user. 

11.2 Including and excluding 

facet values 

11.2.1 Including a facet value 

Facet values can be included and excluded. Including a facet value means 

that only those search results will be shown that match with the included 

facet value. 

Example: The user enters the facet value “PDF Document” and includes 

this facet value with the dropdown menu on the Search button of the facets 

panel. The selections panel in the Cluster Map shows that “PDF Document” 

is an included term. This means that from now only clusters will be shown 

with items that are PDF Documents. 
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11.2.2 Excluding a facet value 

Excluding a facet value means that only those search results will be shown 

that do not match with the excluded facet value. 

Example: The user enters the facet value “PDF Document” and excludes 

this facet value with the dropdown menu on the Search button of the facets 

panel. The selections panel in the Cluster Map shows that “PDF Document” 

is excluded. As long as this exclusion remains, only clusters with items that 

are not PDF Documents will be shown. 
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12 Cluster Map panel 

The Cluster Map shows search results in a graphical format. Since 

the Cluster Map is a new way of presenting search results, this 

chapter will help you to understand how it works. 

 

 

12.1 Understanding a Cluster Map 

The figure above shows labels, clusters and items. The larger spheres are 

clusters. They represent groups of items. Clusters contain smaller spheres 

that represent individual items, such as emails and files. Parts of the 

query, shown as labels, organize the map. Every cluster is connected to 

one or more labels. 

The figure above shows the Cluster Map after the user has evaluated a 

query with two parts: a keyword search for the term “application” and a 

search for Documents using the Type facet. 

The Cluster Map holds two result sets, with the following labels: 
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 “see”: 501 items, red edges 

 “look”: 124 items, blue edges 

The colored edges rendered in the background connect items to labels, 

indicating that these items belong to that result set. An item contained in 

multiple result sets is displayed only once but connected to the labels of the 

sets that contain it. Example: the items in the middle cluster. 

Note:  When a cluster contains more than 250 items, it is displayed as a single 

sphere labeled with the number of items. The individual items are hidden.  This 

prevents clusters with large number of items from disturbing the usability of the 

Cluster Map. 

12.2 Working with Cluster Maps 

12.2.1 Removing result sets 

The result sets created with the current query are listed in the box 

at the top right corner of the Cluster Map panel. To remove a 

result set from the Cluster Map, click on the remove icon (red X) 

in the list. 

To clear the Cluster Map - remove all result sets - and start a new 

search, click the Clear button in the terms list. 

If the Cluster Map regeneration takes too long, you can stop the 

process by clicking the Stop button. 

12.2.2 Opening a search result 

Results can be opened in the viewer by double-clicking on their spheres in 

the graph. Results can also be opened in the Details panel by double-

clicking on the row in table view, or by clicking on the title in list view. 

Tip:  Details about individual results are shown in a tool tip that pops up when the 

mouse cursor is hovered over an item in a cluster. 
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12.2.3 Export cluster map 

You can export the current Cluster Map graph as a PNG image, HTML, or 

XML image map (used to publish the map on a web-page). 

To export the Cluster Map, go to Export > Cluster Map... In the wizard 

dialog, select the desired export format and enter a file name. 

 

12.2.4 Using suggestions 

When the user selects a cluster in the Cluster Map, statistical measures are 

used to determine relevant terms for this set. These terms are listed as 

keyword search suggestions in the Keyword Suggestions facet and can be 

used to narrow down the search. When no selection is made, the union of 

all result sets is used to determine the suggestions. 

12.3 Options 

The Cluster Map options and settings can be accessed through the buttons 

in the Cluster Map toolbar. 

 Display individual results / Display clusters as single 

visual entities 
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These two buttons switch between two modes of cluster 

visualization. In the first mode, each individual item is shown as an 

individual visible item within a cluster. Placing the mouse cursor 

above this item will show information about the item in a tool tip. If 

you do not need this much detail in the graph, you can use the 

second mode, in which individual items are not displayed within 

the clusters. When you click on a cluster, the detailed information 

is shown in the Details Panel. 

 

 Change color scheme 

This button opens a menu to choose a scheme to colorize the 

clusters in the map. There are three color schemes: 

o Result Based Colors (default): in which each query result 

set has its own color. 

o Rank Based Colors: in which the result set that matches the 

most queries has the darkest color. The less it matches, the 

lighter the color. 

o Uniform Colors: where all results have the same color, until 

you make a selection, then the selections takes on a darker 

color. 

 

 Hide less connected clusters 

If this option is enabled, the clusters with fewer connections will be 

hidden. 

 

 Scale the graph to fit the available screen space 

If this option is enabled, the cluster map size will be automatically 

adjusted for the screen space of the panel (no scrollbars will 

appear). This option can also be accessed through View > Cluster 

Map > Scale to fit window. 
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13 Details panel 

In order to inspect the contents of the visualization, the user can select a 

cluster or result set by clicking on it. Its contents will be displayed in the 

“Details” panel below the map. This panel contains a list of the items that 

can be presented in four modes: 

 Table view 

 List view 

 Thumbnails view 

 Timeline view 

Note: Switching display mode is done by clicking the “Display results XXX” 

buttons. With the Display results in a table button you can switch to the table 

view of the results list. Display results in a list shows a list with five results per 

page (configurable in the Preferences panel: File > Preferences). With the Display 

results as thumbnails button you will switch to the thumbnail view. With the 

Display results in a timeline button you will switch to the timeline view. 

13.1 Table view 
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The table view displays the results as a table in which each row represents a 

single item and the columns represent the attributes such as title, date, 

location etc.  

The set of attributes to display can be customized with “Toggle visible table 

columns” button - the right button of the Details Panel Control.  

Click on a table column header to sort the table by specific item attributes. 

13.1.1 Adding and removing columns 

With the “Toggle visible table columns” button in the Details toolbar you 

can add and remove columns in the table, by (de)selecting column names in 

the popup that shows when you click the button. The selected columns are 

stored: every time you start Intella these columns will be shown until you 

select other columns. 

This option is only available in the Table view. 

The following columns are available: 

 Location: Name of the location where the item is stored. This can 

be the name of folder in a file system or the name of an email 

folder. 
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 Name: The file name of a document item. 

 

 Title: The title of a document item. 

 

 Subject: The subject of an email or document item. 

 

 Type: The item's type, such as “MS PowerPoint Document” or 

“Email Message.” 

 

 MIME type: The type of an item according to the MIME standard. 

 

 Size: The item's size in bytes. 

 

 Content Last Modified: Shows the date that the content of the 

item was last modified. 

 

 Content Created: Shows the date that the content was created. 

 

 File Last Modified: Shows the date of the last time the file was 

modified. 

 

 Sent: The date the item was sent. 

 

 Received: The date the item was received. 

 

 Source: The name of the Intella source that holds the item. 

 

 Language: The language of the item's text. The language field is 

left blank when the language cannot be detected automatically. 

 

 Creator: The name(s) of the creator(s) of a document item. 

 

 Contributor: The name(s) of the contributor(s) of a document.   
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 Sender: The name and email address of the sender(s) of an email 

item. 

 

 Receiver: The name and email address of the receiver(s) of an 

email item. 

 

 URI: Uniform Resource Identifier, the identifier used internally by 

Intella for the item. 

 

 Has Attachments: Emails that are marked as having 

attachments. 

 

 Attachments: Shows the file names of an email’s attachments. 

 

 MD5 Hash: The MD5 hash that uniquely identifies the item. 

 

 Duplicates: Shows the number of duplicates of an item within the 

case. 

 

 Flagged: Shows a column at the left side of the table that indicates 

if an item is flagged. Click the checkbox if you want to flag an item. 

 

 Tags: Shows the tags connected to an item. 

 

 Encrypted: Shows if an item is encrypted. 

 

 Comments: Shows if an item has comments. If so, an yellow note 

is shown in the table. Hover over the yellow note to see the 

comments attached to the item in a small popup window. 

 

 Message ID: Shows the Message ID for email messages. 

 

 Message Hash: Shows the Message Hash for email messages. 
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 Previewed: Shows if an item has been opened in the previewer. 

 

 Opened: Shows if an item has been opened in its native 

application. 

 

 Exported: Shows if an item has been exported. 

 

 Unread: Shows if an email item was unread at the time of 

indexing. 

 

 Empty document: Shows that the item has no text while text was 

expected. Example: a PDF file that contains only images. 

 

 Source Path: The path to the evidence, e.g. the PST or NSF file, or 

the root folder of a Folder source. This helps reviewing items when 

dealing with a lot of evidence files – the name of the evidence file 

and the derived source name may not hold enough information to 

easily discern the origin of the information. 

 

13.1.2 Reorganizing table columns 

The columns can be reorganized by dragging a column header to a different 

location in the table. The order is persistent across application sessions, but 

specific to that case. 

13.1.3 Sorting the list 

By clicking on a column header, the search 

results will be sorted alphabetically, 

numerically, or chronologically, depending 

on the type of information shown in that 

column. By clicking the header once more, 

the sort order will be reversed. Clicking one 

more time will remove the sorting, letting the 

results be displayed in their original order. 
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With the “Sort table” button you can extend the sorting setup.  This feature 

allows you to add multiple sort levels, which means that if the first column 

is not met, sorting will be based on the second (third, fourth, etc.) column 

selected.  You can also specify the sort order per column by select ascending 

(A-Z) or descending (Z-A) order. This dialog lets you use all of the columns 

available, regardless of whether the column is currently present in the table. 

Sorting my multiple columns can also be achieved by holding the Ctrl 

button while you click on column names. Any additional column will be 

added to the list of sorting criterions. 

13.1.4 Deduplicating results 

With the “Deduplicate results” button, duplicates are removed from the 

search results list based on the MD5 hashes of the results. The text next to 

the button informs you if duplicates are removed and how many duplicates 

are removed, if applicable. 

Note:  This option is only available in table view. 

13.1.5 Showing a conversation 

Right-clicking an email item and selecting the “Show conversation” option 

will display a new result set in the Cluster Map -- its label starting with 

“Conv: ....”-- showing all e mail items that are part of the conversation, 

including replies and forwarded messages. 

Note:  This option is only available in table view. 

13.1.6 Showing the child items 

To determine all items nested in an item, right-click on the item and select 

Preview. Next, switch to the Tree tab to see the full hierarchy, including all 

child items. 

To determine the children of a set of selected items, select all relevant items 

in the Details table, right-click on one of them and click the “Show children” 
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option. This will open a dialog that asks you what children to put in the 

result set, as child items may also again contain child items. 

13.1.7 Showing the parent items 

Right-click an email attachment and select the option “Preview parent 

email” to view the email message that contains the selected item. This 

feature looks up the parent item recursively until it reaches an email item. 

Note:  This option is only available in table and thumbnails view. 

To determine the parent of a set of selected items, select all relevant items 

in the Details table, right-click on one of them and click the “Show parents” 

option. This will open a dialog that asks you what parents to produce, as 

there may be multiple parents in the path. 

13.2 List view 

List view displays the results in a form similar to conventional web search 

engines (select the third button in the Details Panel Control). For each item, 

the title and other important metadata will be displayed. 

For your convenience, the list is split into separate pages. 

 

13.3 Thumbnails view 
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The Thumbnails view displays the thumbnails of the images detected within 

a selected cluster. This includes images embedded in email attachments 

and images inside documents. 

 

Hover over the thumbnails with your mouse cursor to see a summary of the 

data connected to the image. You can flag an image with the checkbox 

below the thumbnail. 

When you double-click a thumbnail, the image will open in the previewer. 

13.4 Timeline view 

The Timeline view shows a 

chronological representation 

of email communications. 

The left pane shows the 

email senders and receivers, 

with their communication 

plotted chronologically. 

Every arrow in the timeline 

view is an email and points 

to the receiver of the email. 
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The green squares are senders. The red squares are receivers on the To-list. 

The blue squares are receivers on the CC-list. Cyan squares are receivers on 

the BCC list. 

Tip: When you click an arrow, the arrow, the connected arrows, and the 

connected squares will be highlighted. When you double click an arrow, the email 

will show in a preview window. 

 

Tip: Export a timeline by choosing Export > Timeline… from the menu. The 

timeline will be saved as a PNG image. 
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14 Tagging 

Tagging is the process where you connect a descriptive word to an item or a 

group of items. For example: One of your items is a PDF document that 

contains valuable information. You decide to tag the item with the word 

“important.” Tagging helps you to organize results, for example by 

separating important and unimportant information. 

Tagging can be done in several ways in Intella. This chapter gives you an 

overview of the possibilities: 

 Tagging in the main window 

 Tagging in the previewer 

 Letting other items inherit tags automatically 

 Pin a tag to a button 

 See all tagged items 

 Searching with tags 

 Deleting a tag 

14.1 Tagging in the main window 

14.1.1 Adding tags 

To add tags: 

1. Select one or more items from the table, the thumbnail view or 

the timeline. 

 

2. Open the context menu (right mouse click), and select 

“Add tags…” 

 

3. In the “Add tags to x items” dialog you can select already 

defined tags, or define a new tag with optional description. 

When you click OK, the marked tags will be linked to the 

selected items. 
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The Add Tags menu option is also available in the Cluster Map. Right-click 

on a cluster or label to open a popup menu with this and other options. 

 

 

 

 

14.1.2 Removing tags 

If you want to remove a tag, please take the following steps: 

1. Select the items from which you want to remove 

the tags in the table, timeline, thumbnail view, or 

cluster map panel. 

 

2. Open the context menu (right mouse click), and 

select the Remove tags… menu option. 

 

Defined Tags shows a 

list of tags. Select a tag 

name to tag items. 
New Tag 

Define new tag with a 

name and an optional 

description. 

 

Override tag preferences 

Use this checkbox to 

temporarily override the 

settings for tag inheritance as 

set in the Tagging Preferences. 
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3. In the Remove tags from x items dialog select the tags that you 

want to remove, and click OK. 

 

Now the tags are no longer connected to the items. 

Important: Removing a tag does not delete a tag from your case. It only removes 

the connection between a tag and an item. 

14.2 Tagging in the previewer 

If you want to tag or remove a tag in the previewer, please take the 

following steps: 

1. Open the previewer and select the Review tab 

 

2. Click the Tag button to open the tag space 

 

3. Enter a new tag or select an existing tag. To remove a tag (to 

remove the connection between an item and a tag) just deselect 

the tag from the list. 
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Three, six or nine tags can be shown as button in the previewer. When a tag 

is listed as a button, clicking the button results in the tag being assigned to 

the current item. You can set the desired amount of these quick-tag buttons 

in the File > Preferences > Results tab > Previewer section. 

You can also use Ctrl+1, Ctrl+2, Ctrl+3, etc. to quick-tag an item. The 

numbers correspond with the button positions. 

When the 'Auto Advance' toggle button is selected, the previewer will 

automatically switch to the next item in the list. 

14.3 Automatic tag inheritance 

When tagging items, the policy of your investigation may be that some 

related items should be tagged as well. One use case is when tagging items 

as irrelevant: all nested items may then be considered as irrelevant as well. 

Another use is tagging items as privileged; depending on your policy, this 

may then be extended to all other items within the same mail as well. 

Intella offers mechanisms that let these additional tags to be set 

automatically. For more information, see section 18.4. 

14.4 Pin a tag to a button 

In File > Preferences > Results tab > Previewer section you can select the 

number of quick tag buttons: three, six or nine. The default value is three 

quick tag buttons. 

You can pin a tag to a button and keyboard shortcut (Ctrl+1, Ctrl+2, Ctrl+3) 

with the following steps: 

1. Select Tags in the facet panel 

 

2. Right click on a tag in the list to open the context menu. 

 

3. Select “Pin tag to button” and select a number from the 

submenu. 
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Now you can use the buttons in the previewer and the 

keyboard shortcuts to tag an item. 

Tags that are pinned to a button are marked with a small blue 

pin in both the Tag facet and previewer. 

Note: To unpin a tag from a button, select 'Unpin tag' in the context menu of 

Tags. 

14.5 See all tagged items 

To get an overview of all items that are tagged in your case, please take the 

following steps: 

1. Select Features in the facet panel. 

 

2. Select Tagged from the list and click Search 

Now you can see all the items that have a tag in the Cluster Map panel. 

14.6 Searching with tags 

To search with tags, please take the following steps: 

1. Select Tags in the facet panel. 

 

2. Select a tag and click Search 

Now you can see the items that have the selected tag in the Cluster Map 

panel. 

14.7 Deleting a tag 

To delete a tag from your case, please take the following steps: 

1. Select Tags in the facet panel. 

 

2. Right click on a tag in the list. 
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3. Select “Delete” and confirm. 

Now this tag is no longer in your case.  
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15 Exporting 

Intella supports a number of exporting formats, each focusing on a different 

use case. 

15.1 Exporting a single result 

 

A single result can be exported by right-clicking on a row in the Details 

table (or on the item in any of the other views) and selecting “Export…” in 

the content menu. Alternatively, select an item by clicking on it and choose 

Export > Result… in the menu bar. 

A file chooser will open that lets you specify the folder and file name. Click 

“Save” to export the result to that file. The mouse cursor will show a “busy” 

icon while the exporting is taking place. 

The result will be saved in its original format, i.e. a Word document 

attached to a mail gets saved as a Word file. All mails from mail sources 

(PST/OST/NSF/DBX/MBX/Mbox files and IMAP servers) are exported as 

EML files. Evidence files that are already in EML, EMLX or MSG format as 

exported as such. 
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Exporting of a single result may take some time as the original mail 

container (e.g. a PST file) has to be opened and the mail or attachment has 

to be located. 

15.2 Exporting a list of results 

 

To export a collection of items from the current Details view, you first need 

to select all items that need to be exported. Use the mouse button together 

with the Shift or Ctrl key to select blocks of adjacent items, or right-click 

and click “Select all” in the context menu. 

Next, right-click and choose “Export highlighted items…” to open the dialog 

shown above. Alternatively you can use the Export >Result List… option in 

the menu bar. This dialog lets you choose the export formats and further 

configuration options. When you click on the checkbox of an export format, 

all options for that format will unfold beneath the checkbox. 

The folder where the 
generated files will be 
stored. 

Export results in one 
or more formats. 

Select a format type 

to see its 
configuration options. 

An export report lists 
the exported items 
with their paths and 

any error messages 
that may have 
occurred. 

Specify how exported 
files should be named 

(TEAM Manager/TEAM 
Reviewer only), 



Page 132| Intella™ User Manual | © 2011 Vound, LLC 

15.2.1 Exporting to original format 

The “original format” option exports a file into its original format, i.e. a 

Word document attached to a mail gets saved as a Word file. 

All mails from mail sources 

(PST/OST/NSF/DBX/MBX/Mbox files and 

IMAP servers) are exported as EML files. 

Evidence files that are already in EML, EMLX 

or MSG format as exported as such. 

Select the option "Keep location structure" to preserve the original folder 

structure during the export. A folder will be created for every source, in 

which the original folder structure of that source (as shown in the Location 

facet) will be recreated. 

15.2.2 Export to PDF 

Select the PDF format to create PDF 

documents containing the contents of the 

items you selected. 

You can choose to export to individual PDF 

files, one for every selected item, or to 

export all items into one single 

concatenated PDF file. 

When exporting to individual PDF files, 

select the "Keep location structure" option 

to preserve the original folder structure 

during the export. 

When exporting to a concatenated PDF, the 

resulting PDF can optionally be split in 

chunks of a given size. This is 

recommended for performance and 

stability reasons. 
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For all types of items you can indicate whether to include the properties 

and comments. Note that these may include sensitive information such as 

evidence file names, investigator remarks, etc. 

The properties include attributes such as titles, authors, all dates, hashes, 

sizes, etc. 

The comments are those made by reviewers on the item, they are not to be 

confused with e.g. the comments in a Word document. 

When exporting to PDF and Original Format simultaneously, the “Link 

PDF to original format file” option becomes available. When selected, each 

PDF(s) will contain link(s) to the file representing the item in original 

format. 

For emails the following information can optionally be included: 

 The message body. 

 The email headers. 

 A list of all attachments. The file name, type and size of each 

attachment will be mentioned. 

 The actual contents of those attachments. The original view 

(described below) will always be preferred, with the extracted text 

used as a fall-back. 

Note that for emails, a simple header block with the most important 

information like senders, receivers, subject and date will always be 

included. It is not necessary to check the Properties or Headers for that. 

For loose files and attachments that are not emails, the following options 

are available: 

 Include the file’s content. By default, the original view is used, i.e. a 

Word document is rendered as Word would render it, and the 

extracted text is only used when the original view cannot be made, 

e.g. because the file format is not supported. Alternatively, you can 

configure exporting to always use the original view, always use the 

extracted view, or both. 

 List all embedded items, e.g. images found in the document. 
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The following file formats can be exported in their original view: 

 MS Office (doc, docx, xls, xlsx, ppt, pptx) 

 Open Office (Writer, Calc, Impress) 

 WordPerfect 

 RTF 

 HTML 

 PDF 

Note: To export most of these formats in their original form, a local installation 

of MS Office 2010, or an MS Office 2007 installation with the “Save as PDF” add-

in, is required. 

 

We strongly recommend that you do not use any MS Office applications until 

exporting to PDF has completed. Using these applications during exporting can 

result in these applications exiting suddenly and without warning, risking data loss 

on any opened documents. 

15.2.3 Export to PST 

You can export selected emails to a 

PST file. The main purpose of this 

option is to use the PST file as a 

carrier for transport of emails. The 

receiver can open the PST file in 

Microsoft Outlook to see the exported 

emails. 

Select the “MS Outlook PST file” 

option and enter a file name for the 

PST. 

Enter a display and folder name. After 

opening the exported PST file in MS Outlook you will see the names you 

entered. They help you to locate the PST file and its contents in MS 

Outlook. 
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Select the option "Keep location structure" to preserve the original folder 

structure during the export. 

The resulting file can optionally be split into chunks of a given size. This is 

highly recommended for larger result sets that would make the PST grow 

beyond the default suggested file size, as Outlook may become unstable 

with very large PST files. The produced files will have a file size that is close 

to the specified maximum file size (usually smaller). The export report will 

list for every item to which PST it was added. 

How to export non-email items to a PST file? 

Suppose you have a set of results that you want to export, consisting of 

emails and other types of results. By exporting this set to a PST file, you 

would not get the non-email items such as attached PDF files and MS Word 

documents in your export. A PST file can only contain email messages and 

their attachments. Attachments can only become part of the PST by 

including their parent emails instead. 

The Export to PST function allows you to automatically include the parent 

item of attachments being exported to a PST. You can choose to either 

include the top-level email parent or the direct email parent.  An example 

would be an attachment contained within an email message within another 

email message.  With the top-level parent selected all parent items of the 

attachment (both emails) would be included in the PST, one nested within 

the other.  The second option exports the nested email to the PST. You can 

also choose to simply skip non-email attachments. 

Note: Files in a folder source lack a parent email and therefore cannot be 

exported to a PST file, except for EML, EMLX and MSG files. 

How to export attached emails? 

The last setting controls what happens with emails that are selected for 

export and that also happen to be attachments. These are typically 

forwarded messages. Such emails can technically be exported to a PST 

without any restrictions, but the investigation policy may require that the 

parent email is exported instead, to completely preserve the context in 

which this email was found. That can be done by choosing the Replace with 
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its top-level parent email option. Alternatively, use the Export attached 

email option to export the attached email directly to the PST. 

15.2.4 Export to iBase and Analyst’s Notebook 

Intella can export its results into a format that can easily be 

digested with i2’s Analyst’s Notebook and iBase products. All 

metadata of all items, all attachments and all email bodies can 

be imported into these tools, allowing rapid social network analysis and all 

other analytical abilities of these applications on email evidence data. 

Templates, import specifications and instructions are provided for Analyst’s 

Notebook and iBase. Please contact support@vound-software.com for more 

information. 

15.2.5 Export as a Load File 

Intella 1.5.2 introduces the 

ability to export selected 

items as a so-called “load 

file”, for use in legal review 

applications. Currently 

supported are Summation 

DII files and Concordance 

DAT files. 

This functionality is 

currently in beta and may 

change in future versions. 

A future version of this 

manual will describe the 

settings for each type of 

load file in detail.  
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15.2.6 Destination folder 

All produced files will be placed in the 

selected destination folder. 

Though Intella tries not to overwrite any 

files in the specified folder, we recommend specifying an empty folder to be 

sure. 

For every selected format type a subfolder will be created that holds the 

files of that export type. All export reports will be placed in the top folder 

itself. 

When exporting a number of sets to the same destination folder, the 

subfolders with produced files will be merged, but earlier produced files will 

not be overwritten. Each export run will have its own set of export reports. 

15.2.7 File numbering 

By default, exported files will be named using the 

original evidence file’s name or the subject of an 

email. Alternatively, you can choose to number the 

files using consecutive numbers. 

The following options are available: 

 The number to start counting with. By 

default, exporting starts counting at 1. A typical reason to use a 

different number is when you want to combine the exported results 
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with another set of already exported files. Numbers are always 8 

digits long. 

 A prefix. Anything you type here will be added to the beginning of 

the filename. E.g. the prefix “export-” will result in the first email 

being named export-00000001.eml. 

 When items are being exported to PDF, whether the prefix and 

number should be mentioned in the footer of the PDF. 

The file numbering panel is only enabled when Original Format or PDF is 

selected. 

15.2.8 Creating a report 

You can indicate whether you want to 

create an export report for this export. 

The report can be formatted as a PDF, 

RTF, CSV and/or HTML file. 

For PDF, RTF and HTML reports you 

can also add a comment that will be 

displayed on the first page of the 

report. 

Export reports link the original files to the exported files, by listing 

identifying information about the original item (e.g. source evidence file, 

MD5 hash) and linking to the exported file. Also the export report may 

contain information that is lost during export, such as the evidence file’s 

last modification date; like any copy, the export file has the date of export as 

its last modification date. 

Important:  If the export of a specific result resulted in errors, you will be notified 

with an error message in the application. You can find the error notifications at 

the end of the PDF and RTF report or in the last column of the CSV report. 



Page 139| Intella™ User Manual | © 2011 Vound, LLC 

15.3 Exporting to a CSV file 

You can export a results list to a comma separated value (CSV) file. A CSV 

file contains all information listed in the table. CSV files can be opened in a 

spreadsheet application such as Microsoft Excel and can be processed 

through scripting, which opens up new analytical abilities. This 

functionality can also be used to generate MD5 lists. 

To export the table to a CSV file: 

1. Select the results in the table that you want to export to a CSV file. 

 

You can use the Select All option in the right-click menu to easily 

select all rows. 

 

2. Right click on the 

selected files and 

click “Export table 

as CSV…”. 

 

3. Marks the names of 

all columns that 

you want to include 

in the CSV file. 

 

4. Give the CSV file a 

name and select 

Export. 

The selected columns are 

stored so that the next time 

you bring up this dialog, the 

same columns will be selected. Should you frequently use different export 

settings, then you can save these as separate templates. Click the “New…” 

button to create a new template and enter a name. The new template will 

automatically be selected and any selection changes will be stored under 
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that template name. Click the drop-down list to go back to the previous 

(default) template. The settings will now be restored to what they were 

before you created/selected the other template. 

The contents of the Senders and Receivers columns are configurable to 

show either the contact name(s), the email address(es), or both. 

15.4 Exporting a Cluster Map 

You can export the current Cluster Map graph as a PNG image, HTML, or 

XML image map (used to publish the map on a web-page). 

To export the Cluster Map, go to Export > Cluster Map... In the menu bar, 

select the desired export format and enter a file name. 
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16 Previewing results 

 

 

 
  

Item summary: 

shows summary of 

important information 

related to the item. 

Previewer window: 

opens when item in 

table is double clicked. 

Search term hit: 

Location of search 

terms in the text. 

Item tabs:  

inspect an item’s contents, headers, 

properties, attachments, thumbnails, tree 

structure, extracted words, comments and 

performed user actions. 

Previewer 

actions: click 

Review, 

Explore or 
Produce to see 

Previewer 

actions 
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16.1 Overview of the Previewer 

When you double click an item, it will open in the Previewer. This 

component allows you to inspect, flag, and tag the item, to explore its 

relations with other items, and to export the item for later use. 

Below you will find the following information on the Previewer: 

 Explanation of the previewer window. 

 

 Reviewing an item. 

 

 Exploring an item’s relations. 

 

 Producing reports and tabs and exporting an item. 

16.2 Previewer window 

The previewer window has several parts: 

 The top part where you find three task panels: Review, Explore, 

and Produce. Every panel contains a strip of buttons that enable 

operations on the item in the previewer.  

 

 The middle part that 

lists important 

information related to 

the item shown in the 

previewer. 
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 The lower part where you will find tabs such as Contents, Headers, 

Properties, Attachments, Thumbnails, Tree (hierarchy structure), 

Comments and Performed User Actions. The available tabs will 

differ, depending on the type of item you selected.  

 

16.3 Reviewing 

The Review tab opens a strip of buttons that allow you to inspect, tag, and 

flag an item. With the Contents, Headers, Properties, and other tabs you 

can inspect different parts of the item. 

16.3.1 Navigation 

 Previous and Next buttons 

Go to the next or previous item in a list. Alternatively you can also 

use the keyboard shortcuts Alt+right-arrow to go to the next item, 

and Alt+left-arrow to go to the previous item. 

 

16.3.2 Tag 

 Tag button 

Opens the tag space where you can add new tags to your case and 

select a tag from a list of existing tags. 

 

 Quick tag buttons 

You can assign a tag to a quick tag button. Clicking the button tags 

the item and switches the previewer to the next untagged item in 
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the list. If no tag is pinned to a Quick tag button, it is randomly 

associated with one of the recently used tags by default. 

 

 Auto Advance button 

When this button is selected, clicking the quick tag buttons will 

switch the Previewer to the next item in the list. 

 

 Flagged 

Select this check box to flag the previewed item. You might want to 

flag an item for organizational reasons. For example, to keep track 

of the items that you have reviewed in the case. 

16.3.3 Matches 

 Red and green arrowed buttons 

With these buttons you can see where in the Contents and Headers 

tab search terms appear. When you click a button, the text will 

scroll to the place of next or previous search term. 

Tip: When search terms are present in the text of the item they are 

highlighted and the scroll bar of the Contents and Headers tab in the 

previewer will be marked with one or more orange lines. These lines indicate 

where you can find the search terms.  

16.3.4 The Contents tab and other tabs… 

 Contents 

This tab shows the body of an item. 

Note: If the item text is too long, it is truncated in the previewer for 

performance purposes. Click on the "Show full text" button to view the 

complete item text 

 

Note: When an item is encrypted, the Contents tab will show an image 

of a lock, to explain why no text could be shown. 
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 Headers 

This tab shows the complete header of the email item. This tab is 

only shown when you open an email item. 

Important:  Intella indexes all the email headers. You can search for 

words that are only part of the email headers if you select “Summary & 

Description” in the Search panel under Options (see Chapter 

10Searching). 

 Properties 

Shows a list of properties connected to the item. For example: Size, 

Content Created, MIME Type, and Creator. 

The list of properties is different for each type of item. 

To copy all the text to the clipboard click Copy all. 

Tip: Hover over the question marks at the right hand side with your 

mouse and see a short definition of each property. 

 Attachments 

Lists of all the attachments of the email item. This tab is only 

shown when you open an email item. 

Tip: When you double-click an attachment or select it and click View, it 

will be opened in new Previewer window. 

 Thumbnails 

Thumbnails of images (jpg, png, gif etc.) attached to an email item 

or embedded in a document such as the images in a Microsoft 

Word document. 

Select the checkbox below the image to flag a thumbnail. 

Tip:  When you double-click a thumbnail, the image will be opened in a 

new previewer window. 

 Tree 
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Shows the location of the reviewed item in the item hierarchy 
(entire path from root to descendants), as well as all its child items.  

Tip:  The file names and subjects are clickable.  You can also right-click 

and choose to either select all above or select all below, or simply select 

items manually, to assign them to a tag.   

 Entries 

List of entries (items) found in an archive file such as a ZIP file or a 

RAR file. 

Tip: Tip: When you double-click an archive entry or select it and click 

View, it will be opened in new Previewer window. If the entry is a sub-

folder inside the archive, its content will be opened in the same 'Entries' 

tab. Double-click the '..' entry on the top of the list to return to the 

parent folder. 

 Comments 

This tab lists comments attached to the item opened in the 

Previewer. Every comment is has an author name and time stamp, 

and the option to Edit or Delete the comment. 

 

 Words 

The Words tab lists all words/terms extracted from this item, 

together with the following information: 

- the search field the term belongs to: text, title, path, etc. 

- the frequency of the word in this document and document field. 

- the number of documents having this term in the same field. 

This list can be used to diagnose why a certain document is or is not 

returned by a certain query. 

The list can be exported as a CSV file by right-clicking anywhere in 

the table. Right-clicking also lets you evaluate a query with the 

right-clicked term. 
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 Actions 

This tab shows the list of actions performed on an item. The 

action’s date and the user that triggered the action are shown in the 

list. Actions listed are:  

- Previewed- the item was opened in the previewer. 

- Opened - the item was opened in its native application. 

- Exported - the item was exported. 

 

 Preview 

This tab shows the item as if it was opened in its native application. 

The Preview tab is only shown when the format of the current item 

is supported and the Contents tab is not already showing it in its 

native form. The following file formats are supported: 

- Legacy MS Office formats (doc, xls, ppt) 

- New MS Office formats (docx, xlsx, pptx) 

- CSV and TSV files 

- WordPerfect 

- Open Office (Writer, Calc, Impress) 

- RTF 

- HTML 

- PDF 

Note: To preview the MS Office formats, a local installation of MS Office 

2010, or a MS Office 2007 installation with the Save as PDF add-in, is 

required. 

16.4 Exploring 

To explore an item is to learn more about its relation to other items in the 

case. For example, an email might be part of a conversation that contains 

other emails that you would like to investigate. 

16.4.1 Search 

 Show Children 
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Use this button to search for and display the children associated 

with the item being viewed in the previewer.  When selected, a 

search result with the associated children of the selected items will 

be available in the Cluster Map panel.  The label of the cluster will 

be “Children of [file name]” or “Children of [subject].” 

An example of a child item would be an attachment of an email.  

Intella views emails and attachments as separate items.  The 

attachment would be the child of the parent email. 

Child items can have child items of their own. Depending on the 

option that you select, the Show Children shows either only the 

directly nested children or all children in the tree. 

 

 Show Conversation 

Based on the subject of an email item, Intella can find items that 

are part of a conversation. Click the button Show Conversation to 

show all these items in the Cluster Map panel. 

The label of this cluster will be “Conv: [email subject].” The email 

subject is the email subject of the item in the previewer. 

 

 Show duplicates 

When an item has duplicates in the case, click Show duplicates to 

display these duplicates in the Cluster Map.  The label of this 

cluster will be “Duplicates of [file name]” or “Duplicates of 

[subject]”. 

 

 Show Near-Duplicates 

Near duplicates are not identical but share large parts of their 

contents. When an item has near duplicates in the case, click the 

button Show Near-Duplicates to show them in the Cluster Map 

panel. The label of this cluster will be “Near duplicates of [subject]”. 

Note: Intella is capable of finding near-duplicates of an item. Two items are 

near-duplicates when some parts of their contents are equal. Near-duplicates 

are detected during indexing. While exact duplicates of items are detected by 

comparing MD5 hash values, near duplicates are detected with a different 
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mechanism. Based on the words, the frequency of words in a text, and by 

taking out the least significant words, Intella creates a pattern for the item 

that is compared with the patterns of other items. If there is a match 

between the patterns the two items are considered near-duplicates. 

16.4.2 Browse 

 Preview Parent 

Use this button to open the parent item in a previewer window. A 

parent item contains one or more items. Example: Pictures found 

in a Microsoft Word document are separate items in Intella. The 

Word document is the parent item for these pictures. The same is 

true for items found in archive file, such as a ZIP file: The archive 

file is the parent item for these items. 

 

 Preview Parent Mail 

Use this button to open the parent email item in a previewer 

window. A parent email item contains one or more items. Example: 

A picture attached to an email is a separate item in Intella. The 

email is the parent for the picture. 

16.5 Producing 

In the previewer you can export the item and produce two types of reports. 

16.5.1 Export 

 Export 

This button opens the “Export result as” dialog. Enter a name and 

location if you want to store the item. 

 

 Print Tab 

This button opens a print dialog that shows the contents of the 

selected tabs (Contents, Headers, Thumbnails, etc.) of the item. 

Click the print button on the lower right to print the item. 
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 Print Report 

This button opens a print dialog that shows the contents of all tabs 

of the item. If the item has attachments you are asked if these 

should also be printed. Click the print button on the lower right to 

print the item. 

 

16.5.2 External 

 Open 

This button opens the item using the computer's default application 

(e.g. a PDF file would be opened with Adobe Acrobat Reader if that 

is the default PDF viewer on your computer). 
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17 Audit trail 

Every case has an audit trail file that contains a list of all user actions. Every 

line in the file describes a user-initiated action. 

The audit trail file is CSV file that can be opened with Microsoft Excel or 

Open Office Calc. 

You will find the audit trail file in the “audits” folder. This is a subfolder in 

the case data folder. 
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18 Preferences 

To open the preferences dialog, select the File > Preferences menu option. 

To apply changes of the settings, click the Apply button. To apply changes 

and close the dialog box, click the OK button. The Cancel button will close 

the dialog box and discard all unapplied changes. 

The specific settings per tab are explained below. 

18.1 Startup 

 

The Display splash screen while loading a case option controls whether a 

splash screen will be displayed after you have selected a case in the Case 

Manager for opening in Intella. 
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The Restore the queries that were shown last option lets the current 

queries being stored during shutdown, and restores them the next time the 

case is opened. 

The Check for updates on start-up option lets Intella look online for new 

versions of the software during startup. This lookup will only be done once 

in every 24 hours. 

Note: If you enabled this option, Intella will notify you when it was not able to 

check for new updates. A message will be displayed in the upper right corner of 

the main program interface. 

18.2 Search 

 

The Enable Search History option allows you turn off the search history. 

The main use of this is when you do not wish these search terms to be 

recorded – be aware that they are still being added to the audit trail and 

may leave traces in the log file. This setting is also a workaround for 
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character sets (e.g. Korean characters) that cannot be entered properly 

when the history functionality is active. 

The Show Children options allow you to specify what children are returned 

when you click on Show Children in the Previewer or in the search results 

popup menu.  You can specify the level by including only directly nested 

children (direct children only) or directly and indirectly nested children (all 

children).  When you select the Ask every time option, you will be prompted 

for the desired level every time you use Show Children.  

The Show Parents options allow you to specify the level of search by 

selecting top-level parents (all items that are at the root of the hierarchy) or 

direct parents of the item(s). When you select the Ask every time option, 

you will be prompted for the desired level every time you use Show Parents. 

Furthermore, you can set it to only consider the emails in the path. This will 

let all other items be ignored before determining what the top-level or 

direct parent is. Finally, you can let all items that are already top-level items 

be added to the result as well. 

18.3 Results 

The Cluster Map options let you specify whether transitions on the Cluster 

Map should be animated and if so, how long that animation may take. You 

may want to disable animation if it causes performance problems on your 

system. 

Furthermore you can specify whether or not the Cluster Map should 

automatically be scaled when it does not fit inside the window. You can also 

change this option using the Cluster map toolbar button, or go to View > 

Cluster Map > Scale to fit window. 
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The List View setting defines 

the number of items to be 

displayed on a single results 

page when the List View mode 

is used in the Details pane. 

The Thumbnails View setting 

controls which thumbnails are 

shown based on the size of the 

original image in kilobytes. 

Images that are below this 

threshold are filtered out. 

The Previewer setting controls 

the maximum number of 

quick tag buttons that is 

shown in the Previewer.  

18.4 Tagging 

When tagging items, the policy of your investigation may be that some 

related items should be tagged as well, e.g. tagging items in a mail as 

privileged may require that all other items in that same mail are also tagged 

as privileged. The settings in this tab can make that happen automatically. 

The three radio buttons specify how other items in the hierarchy need to be 

handled: 

 Only tag the selected item is self-explanatory. 

 Also tag all attached/nested items results in all attached or nested 

items being tagged with the same tag as well. This works 

recursively, i.e. all children in the hierarchy are tagged. 

 Also tag all other items nested in the same top-level item means 

that everything from the top-level mail down to the most deeply 

nested child gets the tag. 

In addition to these three settings, you can specify that all duplicates should 

also be tagged. When this setting is switched on, all items in the case with 
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the same MD5 or message hash will 

inherit the tag. Furthermore, their 

children or siblings may also be 

tagged automatically, based on the 

setting described above. 

The preferences tab with the tagging 

options can also available by opened 

by clicking the Tag Preferences button 

when creating a new tag. This dialog 

will also let you override the settings 

for the tag currently being set. 

18.5 MS Outlook 

Click Validate to ensure that Intella can locate the Outlook program files on 

the system. This is necessary for the ability to export to PST files. The status 

is shown in the (non-editable) field. 

If validation fails, please consult your system administrator to make sure 

that MS Outlook is installed correctly. 
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18.6 IBM Lotus Notes 

Click Validate to ensure that Intella can locate the Lotus Notes program 

files on the system. The status is shown in the (non-editable) field. 

If validation fails, click the Browse button, select the path to the Lotus 

Notes folder in the file chooser and click Apply. 

Tip: The default installation directories for Lotus Notes is 

 

C:\Program Files\IBM\Lotus\Notes 

 

or on 64-bit systems 

 

C:\Program Files (x86)\IBM\Lotus\Notes 

 



Page 158| Intella™ User Manual | © 2011 Vound, LLC 

19 Menu, mouse, and 

keyboard shortcuts 

19.1 Main Menu 

19.1.1 File 

 Preferences… 

Open the Preferences dialog (see Preferences) 

 

 Exit (Ctrl+Q) 

Exit the application 

19.1.2 Sources 

 Re-index (CTRL+R) 

Recreate all indexes from scratch (after user confirmation). 

 

 Add New... (Ctrl+N) 

Add a new source to be indexed by Intella. 

 

 Edit Sources... (Ctrl+E) 

Open the Edit sources dialog box. 

For a detailed explanation of the source operations, please see 

chapter 9 Sources. 

 

 Edit Evidence Paths… 

Open the Attach Evidence dialog. 

For more information see paragraph 7.2: Evidence paths.  

19.1.3 View 

 Cluster Map 
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o Animate changes 

Turn cluster map animation on or off 

(see also: Preferences) 

 

o Scale to Fit Window 

Turn cluster map size scaling on or off 

(see also: Preferences) 

 

 Details 

o Table 

Switch the Details panel view into Table Mode. 

 

o List 

Switch the Details panel view into List Mode. 

 

o Thumbnail 

Switch the Details panel view into Thumbnail Mode. 

 

o Timeline 

Switch the Details panel view into Timeline Mode. 

 

 Close all previews (Ctrl+Shift+W) 

Closes all open preview windows 

 

 Full screen 

Toggle full-screen mode 

19.1.4 Export 

 Cluster Map... 

You can export current cluster map graph as a PNG image, HTML, 

or XML image map (to publish the map on a web page). In the 

wizard dialog, select desired export format and enter a file name. 
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 Timeline 

Export the timeline as a PNG image. Choose a file name and folder 

in the dialog. 

 

 Terms 

Export all terms in the case. When the results table shows a list of 

results, exporting of the terms of these items is also possible. 

 

 Result... 

Export a single result to a desired location. 

 

 Result List… 

Opens the export dialog to let you export the currently selected 

results. 

19.1.5 Team 

 Set Work Folder… (TEAM Reviewer and TEAM Manager) 

Open the dialog to set the location (folder) where the Intella work 

reports will be stored. Select a folder in the dialog and click Select 

folder.  The default TEAM work folder is C:\Users\USER\Desktop. 

 

 Set User name… (TEAM Reviewer and TEAM Manager) 

Open the dialog to set the name of the person that is doing the 

investigation. This will be used in the work reports. Enter the name 

in the box and click OK. 

 

 Export Work Report… (Ctrl+W, TEAM Reviewer and TEAM 

Manager) 

Open the dialog to export an Intella work report file (.iwr 

extension) to the work folder. 

 

 Open CSV exports… (TEAM Reviewer and TEAM Manager) 

Open the dialog to open CSV files that were created together with a 

work report. Select the CSV file and click Open.  
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Note: The CSV file will be opened in the application that is linked to the CSV 

file type by your operating system. For example: MS Excel or OpenOffice 

Calc. 

 Import Work Report… (Ctrl+I, TEAM Manager only) 

Open the dialog to import an Intella work report. Select an Intella 

work report file (.iwr extension) and click Open. 

 

 Work Reports History…(TEAM Manager only) 

Open the dialog that shows the list of work reports that were 

imported to this case. Every entry in the list has the investigator 

name, the creation date of the Intella work report and the import 

date. 

 

To delete a selected work report from you case, click Remove Work 

Report contents in the Work Reports History dialog. You are asked 

to confirm since this operation cannot be undone. 

19.1.6 Help 

 Help Topics (F1) 

 

 Open Log Folder 

Opens the folder where Intella stores logging information. 

 

 About Intella 

Shows a dialog with three tabs. (1) The first tab contains the version 

number of Intella. (2) The second tab contains system information. 

(3) The third tab shows license information such as ID, type and 

restrictions. 
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19.2 Mouse actions 

19.2.1 Table and thumbnail view 

 Click and drag 

Select multiple items 

 

 Ctrl+click 

Select/deselect items 

 

 Double click on item 

Opens item in previewer window 

 

 Right click on item 

Opens the popup or context menu 

 

19.2.2 Timeline 

 Click on email 

Select an email 

 

 Double click on email 

Opens email in previewer 

 

 Right click on email 

Opens the popup or context menu 

19.2.3 Cluster Map panel 

 Click on cluster or on label 

Select a cluster or a results set 

 

 Click and drag 

Move cluster to reorganize map 
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 Right click on cluster, label or on the selections panel 

Opens the popup or context menu 

19.3 Keyboard shortcuts 

19.3.1 Main window 

 Ctrl+R 

Re-index all sources 

 

 Ctrl+N 

Add new source 

 

 Ctrl+E 

Edit sources 

 

 Ctrl+Q 

Exit the application 

 

 Ctrl+W 

Export work report (TEAM Manager and TEAM Reviewer) 

 

 Ctrl+I 

Import work report (TEAM Manager only) 

 

 Ctrl+Shift+W 

Closes all open preview windows 

 

 F1 

Open Intella help file (requires PDF-viewer, like Adobe Acrobat) 

 

 Spacebar (in thumbnail view) 

Flag selected item 
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 Ctrl+A 

Select all items or text 

19.3.2 Previewer window 

 Alt+Right Arrow 

Move to next item 

 

 Alt+Left Arrow 

Move to previous item 

 

 Ctrl+C 

Copy selected text 

 

 Ctrl+V 

Paste copied text 

 

 Ctrl+A 

Select all text 

 

 Ctrl+1, Ctrl+2, or Ctrl+3 

Tag an item with the tag assigned to button 1, 2 or, 3 in the 

previewer 
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20 Appendix I. HASP 

problem resolution 

20.1 Problem flowchart 
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20.2 Problems and solutions 

20.3 Installation problems 

20.3.1 HASP dongle drivers do not install 

Problem: You are not able to install the HL Key (dongle) drivers. 

Cause: Presence of older HASP HL key drivers installed on the machine 

Solution: Uninstall the older drivers. 

1. Click Start > Run or click the Windows key + R 

2. Enter  

C:\Program 

Files\Vound\Intella\bin\haspd

inst.exe -kp purge and click 

OK.  

3. Wait for message that operation 

was successful.  

Caveat: These steps uninstall ALL other HASP drivers. Make sure you have no 

other HASP dongle that requires an older driver. Install the latest driver.  

20.3.2 HASP dongle not found 

Problem: The following message is triggered "HASP key not found 

(H0007)" 

Possible cause 1: The HASP dongle LED is not lit. The dongle is not 

connected or not properly connected to the USB port. 

Solution 

1. Disconnect, pause a few seconds, then reconnect. If the LED lights 

up, the application should be able to access the dongle. You may 

need to wait a few seconds for the dongle to be completely installed 

by the operating system.  
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2. The required HASP HL key drivers are not installed. If you are 

running HASP SRM on a Windows platform, check for an entry for 

HASP SRM in the Device Manager utility. If there is no entry, you 

must install the drivers.  

3. Check if the USB port is functioning correctly. Disconnect all other 

USB devices from their respective ports. Connect the HASP dongle 

to a different USB port. Try using a different USB device in the port 

from which the dongle was not accessible to test if the port is 

actually working.  

Possible cause 2: HASP License Manager Service is not running. 

Solution 

1. Check if the HASP License Manager Service is running by opening a 

Command Prompt (Start > All Programs > Accessories > Command 

Prompt)  

2. Enter: sc query hasplms 

3. Check the result. It should show like this... 

SERVICE_NAME: hasplms 

TYPE : 10 WIN32_OWN_PROCESS 

STATE : 4 RUNNING 

(STOPPABLE,NOT_PAUSABLE ,IGNORES_SHUTDOWN) 

WIN32_EXIT_CODE : 0 (0x0) 

SERVICE_EXIT_CODE : 0 (0x0) 

CHECKPOINT : 0x0 

WAIT_HINT : 0x0 

If you see RUNNING the hasplms is running. 

20.4 Hardware problems 

20.4.1 No dongle detected 

Problem: The computer does not detect the dongle. There are several 

potential causes, listed below. 
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Cause 1:Conflict with other USB devices 

On occasion, the presence of other USB devices may cause problems with 

the HASP dongle.  

Solution: Remove conflicting USB device/devices 

Cause 2:Incorrect device driver installed 

The HASP dongle may not function if an incorrect version driver is 

installed. 

Solution: see section Installation problems, HASP dongle drivers do not 

install. 

Cause 3:USB port is defective or HASP dongle not properly inserted 

Solution: Check that the LED light is lit on the dongle. If not, remove and 

reinsert. Wait for the operating system to detect the dongle. If it still does 

not light up, try another USB port or use a USB hub.  

Cause 4:Faulty dongle 

On rare occasions one may get a faulty dongle. The dongle neither lights 

nor is detected in Device Manager, even with proper driver installed. 

Request a replacement. 

20.5 Firewall & anti-virus 

problems 

20.5.1 Unable to access HASP SRM RunTime 

Environment (H0033) 

Problem:  

The error message: "Unable to access HASP SRM RunTime Environment 

(H0033)" might be caused by too restrictive firewall settings. 

Possible causes: 

 C:\WINDOWS\system32\hasplms.exe is blocked by firewall or 

antivirus application. 

 Port 1947 is blocked by a firewall application. 
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 HASP License Manager Service is stopped.  

Preliminary test: 

1. Disable all antivirus and firewall applications. Note that some 

applications such as Norton, McAfee, and AVG have both antivirus 

and firewall settings that may need to be individually disabled. 

2. If the HASP License Manager Control Center does not appear in 

the browser at http://localhost:1947 then we know that the 

anti-virus or firewall application will have to be configured. 

3. If the Control Center still does not appear, check for other firewall 

or antivirus applications that may be running and disable them or 

turn them off.  

Solution:  

1. Add C:\WINDOWS\system32\hasplms.exe in the Exception list 

of the antivirus and firewall application 

2. Add port 1947 to the Exception list  

3. Restart the HASP License Manager Service (Control Panel > 

Administrative Tools > Services)  

Important: You must perform an installation “Reinstall” of Intella as the antivirus 

software may have blocked components during the first install.  
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Example of a firewall exception: 

 

The following information is adapted from the SafeNet Sentinel HASP 

knowledgebase. 

Message: "Unable to access HASP SRM RunTime Environment (H0033)"  

Problem: This error means that there is a communication error between 

the program and the local license manager. This error can be triggered by a 

number of causes, including (1) improper installation of the HASP RTE 

software, (2) personal firewall software blocking communication with the 

HASP LMS service, or (3) other software using the same port that the HASP 

License Manager uses (i.e. port 1947). 

Solution: To troubleshooting the error follow the steps below until the 

cause for the error is found: 

1. Open a web browser and connect to http://localhost:1947. 
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This is the HASP SRM Admin Control Center. If it's possible to 

connect to this page, then the HASP SRM Runtime is installed 

properly. The problem lies elsewhere and you can disregard the rest 

of this document.  

 

If you get a message Page cannot be displayed then it's possible 

that HASP SRM Runtime is not installed (go to step 2) or blocked 

(go to step 3 and 4). 

 

2. Go to Start > Run, enter services.msc and click OK. 

 

The list is alphabetical. Search for HASP License Manager in the 

table and then check if its status is “Started”  

 

If this entry is not listed, then the HASP SRM Runtime is not 

installed. Please reinstall it. 

 

If the status is not “Started” check the event log for entries relating 

to the HASP License Manager service that will give an error 

message and further diagnostic information. 

 

3. Check your personal firewall software. There are many types of 

personal firewall software including Norton Internet Security (the 

Firewall is one component of this software), ZoneAlarm and others.  

 

By default most personal firewall software will request permission 

to allow access for the HASP License Manager the first time it is 

run. If access is allowed there should be no problems.  

 

If access is denied you will encounter communication problems. To 

resolve such problems either disable the firewall completely (Note: 

this option has risks. Please contact your firewall vendor for 

details) or create a rule or exception in the firewall to allow the 

HASP License Manager communication. If there is an option to 
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create a rule/exception based on a port number, allow port 1947. 

 

As there are many personal firewall products on the market it is not 

possible to list all the ways to configure each piece of software here. 

Please contact your firewall vendor for details on how to create 

exceptions or rules as detailed above.  

 

4. Check that there aren't any applications that use HASP registered 

port (Port 1947). If you find such a program, disable it and run the 

HASP application again. 

20.6 Normal operation 

Dongle installation 

Intella is shipped with the latest SafeNet HASP dongles. 

Intella is packaged with the SafeNet HASP RTE installer. 

When correctly installed, the Windows  

Device Manager reports three items in the 

“Universal Serial Bus controllers” section:  

 SafeNet HASP HL Key 

 SafeNet HASP Key 

 SafeNet USB Key.  

When incorrectly or incompletely installed, 

warning icons appear on the device.  

 

 

 

HASP License Manager Service 

The HASP installer includes the HASP License Manager application that 

runs as a system service: 

C:\WINDOWS\system32\hasplms.exe  
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The HASP License Manager Service hasplms.exe must be running to 

allow Intella to open. When this application is running you should be able 

to load the HASP License Manager Admin Control Center by entering 

http://localhost:1947 in an internet browser. 

 

HASP SL is the trial version 

license. 

HASP HL will only show when 

the dongle is plugged in.  

 

Windows system services 

A good indication that the License Manager Service is running properly, is 

that the entry is flagged as “Started” in the table of Windows system 

services: 
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20.7 Installation flowchart 

 

 

 


